National NHS Staff Survey 2010

Guidance Notes
# Table of Contents

## Introduction

### Part One - *Introduction to the National NHS Staff Survey*

1.1. Background to the survey .................................................. 4
1.2. Summary of minimum survey requirements for Trusts .............. 5
1.3. PCT participation in the 2010 survey .................................. 5
1.4. Summary of minimum survey requirements for Strategic Health Authorities and other NHS organisations ........................................ 6
1.5. Timetable for the survey .................................................... 6
1.6. Changes since the 2009 survey .......................................... 7
1.7. Health and Safety Executive Management Standards .............. 7
1.8. Immediate preparation for the 2010 survey .......................... 7

### Part Two - *Step by step instructions for the National NHS Staff Survey*

2.1. Key survey contacts within the Trust ................................ 10
2.2. Approved Contractors ...................................................... 10
2.3. The questionnaire ........................................................... 11
2.4. Breakdown of results by directorate / department / site .......... 15
2.5. Preparation of staff lists .................................................. 14
2.6. Selecting the Staff Sample ................................................. 19
2.7. Pre-survey communication with staff .................................. 25
2.8. Boosting response rates .................................................... 26
2.9. Printing of questionnaires, covering letters and reminder cards / letters .......................................................... 27
2.10. Distribution and receipt of questionnaires, and prompting non-respondents ..................................................... 29
2.11. Data entry and data transfer to the Advice Centre ............... 32
2.12. Reports of the survey findings ........................................ 38
2.13. Ethical considerations ...................................................... 39

**Appendix 1**: Text of covering letter sent with first questionnaire 40
**Appendix 2**: Text of first reminder letter ................................. 41
**Appendix 3**: Text of second reminder letter .............................. 42
**Appendix 4**: Summary of information to be transferred to the Advice Centre .................................................. 43
**Appendix 5**: How to select a random sample in Excel ............... 44
**Appendix 6**: Contact details of Approved Contractors ............... 45
**Appendix 7**: Questions that map to the Health and Safety Executive Management Standards ................................................................. 46
**Appendix 8**: Questions that can be used by trusts to continue monitoring against the Improving Working Lives (IWL) standard 47
**Appendix 9**: Changes to questions in the 2010 Core Questionnaire 49
**Appendix 10**: Ethnic Background codes to be included in staff list 51
**Appendix 11**: List of Care Trusts and version of the questionnaire to be used 52
National NHS Staff Survey 2010 Guidance Notes

Introduction

The main purpose of these Guidance Notes is to guide NHS Trusts and survey contractors through conducting the National NHS Staff Survey. These notes are in two main sections.

Part One - Introduction to the National NHS Staff Survey

1.1. Background to the survey
1.2. Summary of minimum survey requirements for Trusts
1.3. PCT participation in the 2010 survey
1.4. Summary of minimum survey requirements for Strategic Health Authorities and other NHS organisations
1.5. Timetable for the survey
1.6. Changes since the 2009 survey
1.7. Health and Safety Executive Management Standards
1.8. Immediate preparation for the 2010 survey

Part Two: Step by step instructions for the National NHS Staff Survey

2.1. Key survey contacts within the Trust
2.2. Approved Contractors
2.3. The questionnaire
2.4. Breakdown of results by directorate / department / site
2.5. Preparation of staff lists
2.6. Selecting the Staff Sample
2.7. Pre-survey communication with staff
2.8. Boosting response rates
2.9. Printing of questionnaires, covering letters and reminder cards / letters
2.10. Distribution and receipt of questionnaires, and prompting non-respondents
2.11. Data entry and data transfer to the Advice Centre
2.12. Reports on the survey findings
2.13. Ethical considerations

The appendices contain templates of the cover letter to accompany the questionnaire and the reminder letters, as well as details of information and documents to be transferred to the Advice Centre. They also include a list of changes to the Core questionnaire from 2009, details of questions that can be used to identify areas of concern as outlined in the Health and Safety Executive’s Management Standards, questions that map to the standards of Human Resources practice set out in Improving Working Lives and some detailed instructions for carrying out basic operations in Excel (necessary for the sampling stage).

An Advice Centre website and advice line is available for the National NHS Staff Survey.

- Website: www.nhsstaffsurveys.com
- Advice Line: 0121 204 3131 (9.30am – 4.30pm, Monday to Friday).
- E-mail: enquiries@nhsstaffsurveys.com

Researchers from the Advice Centre will provide practical support and advice to the Trusts as they conduct the survey.
PART ONE: INTRODUCTION TO THE NATIONAL NHS STAFF SURVEY

1.1. Background to the survey

In 2003, the Commission for Health Improvement (CHI), in conjunction with the Department of Health (DH), appointed Aston University to develop and pilot a new national NHS staff survey, and to establish an Advice Centre and website to support that process. The three organisations worked in partnership to consult widely with NHS staff about the content of the survey under the guidance of a stakeholder group, which had representatives from Staff Side, CHI, DH, HR Directors, Strategic Health Authorities and the NHS workforce.

The purpose of this survey was to collect staff views about working in their local NHS Trust. It was designed to replace Trusts' own annual staff surveys, the Department of Health 10 core questions, and the CHI Clinical Governance Review staff surveys. It was intended that this survey would be implemented annually and cover the needs of CHI, DH and Trusts. The survey was used to provide information for both national performance measures (including star ratings) and for helping the NHS, at both a national and local level and, up to 2007, monitor the Improving Working Lives standard.

After a pilot study in five Trusts, the survey was implemented in full in the autumn of 2003. Every NHS Trust in England took part, with nearly 370,000 staff sent questionnaires. 56% of these responded, and the data were analysed by the Advice Centre at Aston University. The survey was repeated in 2004 and 2005, with even higher response rates of 60% and 58% respectively.

A large number of Primary Care Trusts (PCTs) underwent major reconfiguration in October 2006 and, as a consequence, were not required to participate in the 2006 National NHS Staff Survey. In total, only 326 NHS Trusts in England took part in October 2006 and 54% responded. All NHS Trusts in England again participated in the survey in October 2007, 2008 and 2009 with response rates of 54%, 55% and 55% respectively. We anticipate that all NHS Trusts in England, including PCTs, will participate in the survey in the 2010 survey (see section 1.3).

In 2007 the DH, in conjunction with Ipsos MORI, conducted a piece of research, referred to as 'What Matters to Staff in the NHS'1, which tried to identify the major factors contributing to staff engagement and motivation to provide high quality patient care. These themes informed the Next Stage Review2 and the staff pledges in the NHS Constitution3, which have brought a renewed focus on the NHS as an employer. The latter includes four pledges to staff that set out, for the first time, what the NHS expects from its staff and what staff can expect from the NHS as an employer:

**Pledge 1:** To provide all staff with clear roles and responsibilities and rewarding jobs for teams and individuals that make a difference to patients, their families and carers, and to communities.

**Pledge 2:** To provide all staff with personal development plans, access to appropriate training for their jobs and the support of line management to succeed.

**Pledge 3:** To provide support and opportunities for staff to maintain their health, wellbeing and safety.

**Pledge 4:** To engage staff in decisions that affect them and the services they provide individually, through representative organisations and through local partnership working arrangements. All staff will be empowered to put forward better ways to deliver better and safer services for patients and their families.

1 [www.dh.gov.uk/en/Publicationsandstatistics/Publications/DH_085536](http://www.dh.gov.uk/en/Publicationsandstatistics/Publications/DH_085536)
2 [www.ournhs.nhs.uk](http://www.ournhs.nhs.uk)
3 [http://www.dh.gov.uk/nhsconstitution](http://www.dh.gov.uk/nhsconstitution)
Information collected from the Staff Survey can be used by Trusts to improve working conditions and practices, and to monitor against the pledges to staff. Survey findings will be used by the Care Quality Commission as part of the ongoing monitoring of registration compliance. The survey will also enable the Department of Health and other national NHS bodies to assess the effectiveness of national workforce policies and strategies on for example, training, flexible working policies, and safety at work, and to inform future developments in these areas, and monitoring the pledges to staff.

Each year, all participating Trusts receive a feedback report that compares their scores with those of all Trusts of a similar type, and these are available on the Care Quality Commission website (www.cqc.org.uk/aboutcqc/howwedoit/engagingwithproviders/nhsstaffsurveys.cfm). Additionally, the Care Quality Commission published a national ‘Key Findings’ report summarising changes at a national level.

1.2. Summary of minimum survey requirements for Trusts

It is expected that all NHS Acute Trusts, Ambulance Trusts, Mental Health / Learning Disability Trusts, Care Trusts and PCTs in England will implement the survey in the Autumn of 2010. All participating Trusts must follow a standard methodology, as described in these guidance notes, and must fulfil the following minimum requirements:

- A self-completion questionnaire with a random sample of staff (see section 2.6 for more details on sampling).
- The questionnaire must contain the full set of Core questions (see section 2.3 for more details on the questionnaire).
- A staff survey communication strategy must be implemented (see section 2.7 for more details on internal communication).
- Questionnaires (each labelled with a unique staff ID number) to be distributed to selected staff, with at least two reminders being sent to non-responding staff (2nd reminder to be accompanied by a 2nd copy of the questionnaire) (see section 2.10 for questionnaire distribution procedures).
- An external organisation must be appointed to act as a survey contractor. As a minimum, this organisation should be responsible for receipt of completed questionnaires, data entry and editing, and provision of this data to the Advice Centre. It is strongly recommended that Trusts use one of the Approved Survey Contractors (see section 2.2 for details of the Approved Contractors).

There are a number of additional ways in which Trusts can adapt the survey to their local needs. Trusts may:
- Conduct a survey with a larger staff sample or census.
- Select additional questions from an Optional Question Bank.
- Include a limited number of their own local questions on other topical issues.

More detail about all these survey elements can be found later in sections 2.3, 2.4, 2.5 and 2.6.

1.3 PCT participation in the 2010 survey

All Primary Care Trusts (PCTs) commissioner and provider units, either as existing PCTs or new provider/commissioner units, are expected to take part in the 2010 survey.
The revised NHS Operating Framework 2010/11 states that separating out PCT commissioning from the provision of services remains a priority, and must be achieved by April 2011. PCTs are at varying stages of transformation but many will now be reviewing plans and options with their SHAs with a view to substantial progress on implementation by 1st April 2011. We expect that only a small proportion of PCTs will have divested their provider arms by September 1st 2010.

The revised framework also states that ‘every provider of community services should carry out staff experience surveys at least once a year’. We can achieve this by adopting effective sampling strategies:

- **PCTs that divest their Provider functions before September 1st 2010** should proceed with the survey as a new Commissioning Unit. The Advice Centre will provide a benchmarked feedback report for this new organisation in late February / early March 2011. Provider staff should be included in the staff list of the Acute or Mental Health Trust they have joined. Although staff responses will refer to an organisation to which they no longer belong, the data will describe their experience of the NHS as an employer.

- **PCTs due to divest their Provider functions between September 1st and 31st December 2010** should carry out a full census of the Commissioning part of the PCT. The Advice Centre will provide a benchmarked feedback report for the new Commissioning only PCT in late February / early March 2011. A separate survey, using the procedures set out in section 2.6, should also be conducted of Provider staff. The Advice Centre **will not** provide a separate feedback report for Provider staff (this will be produced by the survey contractor appointed to conduct the survey). We recommend that payment decisions are decided locally but envisage that, in most cases, the PCT will pay once for the contractor to survey both their provider and commissioner staff.

- **PCTs due to divest their Provider functions between January 1st and March 31st 2011** should carry out a full census of Commissioning staff, plus survey a sample, (using the procedures set out in section 2.6), of Provider staff. The Advice Centre will provide a benchmarked feedback report based on data collected from both the Commissioning and Provider elements of the PCT in late February / early March 2011. Conducting a full census of the Commissioning arm of the PCT will also provide benchmark data for the new commissioning organisation.

**1.4 Summary of minimum requirements for Strategic Health Authorities and other NHS organisations**

Strategic Health Authorities and other NHS organisations, including NHS Direct, are encouraged to conduct the survey, although it is not compulsory. A separate version of the questionnaire has been produced for SHAs and other NHS organisations. We would strongly recommend the use of an Approved Contractor as this is the only way to guarantee to staff that no one in their organisation would see any completed questionnaires, and that all the minimum requirements set out above in section 1.2 are adhered to. Please note that due to the small number of SHAs, it will not be possible for the Advice Centre to produce a feedback report for each SHA – this service would be provided by the Approved Contractor appointed to conduct the survey.

**1.5. Timetable for the survey**

Questionnaires should be distributed no later than the week commencing 27th September 2010, but may be sent out up to a month before this if that is more convenient for Trusts (e.g. to attach the questionnaires to payslips).
during week commencing 27th September), Trusts should distribute a first reminder letter to all staff who have not yet returned a questionnaire.

A second reminder letter, together with an extra copy of the questionnaire, should be distributed to non-responding staff a further three weeks later (week commencing 8th November, if the initial mailing was in week commencing 27th September).

Survey data should be transferred to the Advice Centre during the week commencing 6th December 2010.

The Advice Centre will produce reports of national results and Trust level results in late February / early March 2011. Trusts are, however, able to commission additional reports based on their own data from their contractors which can be produced before the standard reports they receive from the Advice Centre.

A detailed timetable for the survey can be found in PART 2 (page 8).

1.6. Changes since the 2009 survey

See appendix 9 for further information on the changes made to the content of the questionnaire(s). There are no changes to the survey procedures.

1.7. Health and Safety Executive Management Standards

As in previous years, the questionnaire includes a number of questions which can be used to identify whether work-related stress is of concern in an NHS Trust and these questions can be mapped to the Health and Safety Executive’s (HSE) Management Standards (see Appendix 7 for further information).

1.8. Immediate preparation for the 2010 survey

There are a number of key tasks that should be started as soon as possible to ensure that organisations are ready to conduct the survey:

- Updating of the Trust staff database, including accuracy of work address information (or home address information if applicable – see section 2.5), in preparation for selecting the staff sample (see sections 2.5, 2.6).
- Trusts have the option of TWO within-Trust breakdowns (e.g. directorate and location) to be included within the Advice Centre feedback reports (see section 2.4). Details of the within-Trust breakdowns should be included in the Trust staff database supplied to contractors.
- PCTs are asked to supply details in the staff list (and Basic Sample) on whether staff members are employed in a ‘provider’, ‘commissioning’ or ‘other’ role (see section 2.5). Employment in a ‘provider’ role includes staff within PCT direct provider organisations that have moved into a contractual relationship with their commissioning PCT. Where there are sufficient numbers of respondents, PCTs will be provided with a breakdown of the ‘Key Findings’ for staff employed in ‘provider’, ‘commissioning’ and ‘other’ roles.
- Making contact with the Advice Centre to let them know which members of staff will be responsible for the survey implementation (please see section 2.1).
- Making contact with an Approved Survey Contractor who will be able to help the Trust with the preparation for and implementation of the survey (see section 2.2).
PART TWO: STEP BY STEP INSTRUCTIONS TO THE NATIONAL NHS STAFF SURVEY

The Advice Centre, based at Aston University, has been set up to support the whole process. You will have access to staff at the Advice Centre via email or through the helpline throughout the survey period.

See page 3 for details of how to contact the Advice Centre.

The timetable of steps necessary for survey implementation can be seen below:

<table>
<thead>
<tr>
<th>Date</th>
<th>Step of Survey Implementation</th>
<th>By whom?</th>
<th>Section in Guidance Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>By mid-August</td>
<td>Identify two individuals within the Trust who will take responsibility for the survey and inform the Advice Centre of their contact details</td>
<td>Trust or contractor</td>
<td>2.1</td>
</tr>
<tr>
<td>w/c August 23rd</td>
<td>Ensure staff lists are comprehensive and up to date (for PCTs this should include details of whether staff members are employed in a 'provider', 'commissioning' or 'other' role )</td>
<td>Trust</td>
<td>2.5</td>
</tr>
<tr>
<td>By 10th September</td>
<td>Appoint a survey contractor to administer the survey</td>
<td>Trust</td>
<td>2.2</td>
</tr>
<tr>
<td>By w/c September 6th</td>
<td>Agree the precise division of labour between Trust and contractor (e.g. who is responsible for sampling, printing, packing survey materials for distribution, taking receipt of completed questionnaires, monitoring response rates etc)</td>
<td>Trust and contractor</td>
<td>2.2</td>
</tr>
<tr>
<td>By w/c September 6th</td>
<td>Decide on the precise content of the questionnaire and communicate this to contractor (all Trusts must include the Core questions)</td>
<td>Trust</td>
<td>2.3</td>
</tr>
<tr>
<td>By w/c September 6th</td>
<td>Decide on what within-Trust breakdown (e.g. directorate, department or location) should be used, and ensure that this information is included in the staff list</td>
<td>Trust</td>
<td>2.4</td>
</tr>
<tr>
<td>By w/c September 13th</td>
<td>Communicate with Trust staff. Arrange internal publicity about the forthcoming survey. Include intention to distribute questionnaires to home addresses, if applicable.</td>
<td>Trust</td>
<td>2.7</td>
</tr>
<tr>
<td>By w/c September 20th</td>
<td>Arrange printing of the various survey documents - questionnaires, letters, reply-paid envelopes (each questionnaire to be printed or labelled with a unique staff identification number to allow monitoring of response rates and targeting reminders)</td>
<td>Trust or contractor</td>
<td>2.9</td>
</tr>
</tbody>
</table>
| Date                  | Step of Survey Implementation                                                                 | By whom?         | Section in Guidance
|-----------------------|-------------------------------------------------------------------------------------------------|------------------|----------------------
| By w/c September 20th | Inform the post room(s) of the forthcoming questionnaire distribution and reminders, ensuring that they are aware of the importance of the survey and the likely volume of post | Trust            | 2.7                  |
| By w/c September 20th | Set up service contracts with the contractor if home addresses are to be used for questionnaire distribution | Trust and contractor | 2.5                  |
| w/c September 27th 1 | Arrange distribution of questionnaires to the selected sample via the internal post or home addresses | Trust or contractor | 2.10                 |
| Weekly during survey period | Monitor response rates to this first mailing, and use the unique ID numbers on returned questionnaires to record which members of staff have not yet responded | Contractor       | 2.10                 |
| Weekly during survey period | Inform Advice Centre of ongoing response rates and the number and nature of helpline queries received | Contractor       | 2.10                 |
| w/c October 4th      | Inform Advice Centre of the total number of staff eligible to receive the survey and the size of the Basic Sample selected, and details on whether the Electronic Staff Record database was used to create the staff list used to create the Basic Sample | Contractor       | 2.5 / 2.10           |
| w/c October 4th      | Confirm with Advice Centre which benchmarking groups should be used for feedback reports       | Trust and contractor | 2.12                 |
| w/c October 18th 2   | Three weeks after the initial mailing, arrange distribution of a reminder letter to all staff who have not yet returned a questionnaire | Trust and contractor | 2.10                 |
| w/c November 8th 3   | Three weeks after the first reminder letter, arrange distribution of a 2nd copy of the questionnaire to all non-responding staff together with a reminder letter and another reply-paid envelope | Trust and contractor | 2.10                 |
| w/c December 6th     | Arrange for keyed or scanned data from the completed questionnaires to be transferred to the Advice Centre in the prescribed format | Contractor       | 2.11                 |

1,2,3 Or earlier date: see section 2.10
2.1. Key survey contacts within Trust

At the start of the process, it is important to identify two people within the Trust who will take responsibility for the survey and communication with the Advice Centre and the survey contractor. If your Trust has not already informed the Advice Centre of the names and contact details of these individuals, please do so immediately.

2.2. Approved Survey Contractors

We strongly recommend that Trusts appoint an approved survey contractor to support them. These contractors were chosen by the Care Quality Commission in 2010 having demonstrated that they are able to provide a high quality service, whilst offering value for money. On the basis of the tenders submitted by the contractors, the Care Quality Commission selected three Approved Contractors to enter a framework arrangement to provide services supporting the NHS staff survey to NHS trusts. It is not therefore necessary for Trusts to conduct their own tender exercises.

All of the Approved Contractors have been briefed by, and will work closely with, the Advice Centre staff throughout the survey period. Furthermore, all Approved Contractors have contracts with the Care Quality Commission, under which they guarantee the provision of a high quality service. The three Approved Contractors are:

- CAPITA Health Service Partners
- Picker Institute Europe
- Quality Health

Contact details for these contractors can be found in Appendix 6. When using an Approved Contractor, Trusts can select from a menu of services, including:

- Providing advice and support to Trusts in selecting the staff sample.
- Printing questionnaires, covering letters and reminders.
- Packing up survey materials ready for internal distribution by the Trust.
- Handling receipt of completed questionnaires, liaising with Trusts about non–responses and the distribution of reminders*.
- Providing support to ensure good response rates.
- Data entry and transferring the cleaned data to the Advice Centre*.
- Analysis and reporting of findings (N.B. The Advice Centre will be providing a basic report of the core question findings in late February / early March 2011 (see section 1.2 for PCT exclusions).

(* it is mandatory that these elements are handled by an external contractor for confidentiality reasons.)

The work carried out by the approved contractors may vary from Trust to Trust. While some Trusts may choose to appoint a contractor to conduct the whole survey, others may wish to do some of the work themselves in order to keep costs down. When deciding for which parts of the process to use the contractor, it is worth remembering that the use of an approved contractor can help to limit the burden on Trust staff time. The amount of staff time needed to co-ordinate a large-scale survey is often under-estimated. In particular, organising the printing and packing of survey materials can be very time-consuming tasks, and can take Trust staff away from their usual work.

Although we strongly recommend using an Approved Contractor, it is recognised that some Trusts may choose to use a non-approved contractor. If this is the case, it is essential that the instructions are followed very carefully as we need to ensure all Trusts are producing data that is comparable. It is also important that non-approved contractors provide the Advice Centre with their details so updates etc can be sent if necessary and so data may be passed between the contractor and Advice Centre without compromising respondent confidentiality.
2.3. The Questionnaire

The next step is to decide on the content of the questionnaire to be used in your staff survey. The questionnaire has three potential components, only one of which is compulsory:

- A set of Core (compulsory) questions, which must be asked in all Trusts.
- A set of Bank (optional) questions.
- Local questions.

All Trusts must include the full set of Core questions in their questionnaire, but also have the option of selecting additional questions from the bank of optional questions. These can be put together using a Compilation Tool available on the Advice Centre website (www.nhsstaffsurveys.com) from w/c August 16th (see section 2.3.4). It is hoped that the Core and optional Bank questions will cover key staff issues for the majority of Trusts. However, Trusts can also include additional questions to cover issues of local interest.

2.3.1. Core Questions

As in 2008 and 2009, there will be different versions of the Core questionnaire for each of the four main sectors (acute, ambulance, mental health and primary care), and a further version of the questionnaire for SHAs and other NHS organisations.

The majority of the content is the same across the different versions of the Core questionnaire and covers:

- WORK-LIFE BALANCE
  o Questions about the respondents’ working hours, use of flexible working and support for work-life balance.

- TRAINING, LEARNING AND DEVELOPMENT
  o Questions about the type and quality of the training, learning and development respondents have received.

- YOUR JOB AND ORGANISATION
  o Questions about the respondents’ experiences of working at their Trust and in the NHS, including: the support and guidance received from immediate managers, the type and quality of appraisals respondents have received, team working, involvement in decision making, work pressure, job satisfaction, intention to leave, the role of senior managers, equal opportunities and whistle-blowing, opportunities to develop their potential, making a difference to patients and understanding how their role fits in, having opportunities to improve the way they work and how engaged staff are in their jobs.

- ERRORS, NEAR MISSES AND INCIDENTS
  o Questions about witnessing and reporting errors, near misses and incidents, and actions taken by the Trust.

- VIOLENCE, BULLYING AND HARASSMENT
  o Questions about experiences of violence, bullying and harassment, and actions taken by the Trust.

- OCCUPATIONAL HEALTH AND SAFETY
  o Questions about types of injuries and illness suffered by staff and support offered to staff.

- INFECTION CONTROL AND HYGIENE
  o Questions about the provision of hand washing materials for staff, patients and relatives, and visitors to the Trust.
• HEALTH AND WELL-BEING
  o Questions about the respondents’ general level of health.

• BACKGROUND DETAILS
  o Questions about the respondents’ age, gender, ethnic background, occupational group, and how long they have worked at their NHS trust, whether they have contact with patients, and line management responsibilities.

In addition, there are a number of ‘sector-specific’ questions on the following topics:

**Acute Trusts**

• Promotion of infection control (included as a Core question in the Acute Trust version of the Core questionnaire, and can be included as an optional question in the Ambulance Trust, Mental Health / Learning Disability Trust and PCT versions of the questionnaire).

**Ambulance Trusts**

• Communication between Trust headquarters and ambulance stations.
• Distance between Trust headquarters and ambulance stations.

**Mental Health / Learning Disability Trusts / PCTs**

• Mental health specific training (included as a Core question in the Mental Health / Learning Disability Trust version of the Core questionnaire, and can be included as an optional question for PCTs).

A number of 2009 Core questions have either changed in format or have been moved to the 2010 optional Bank. All the changes are listed in more detail in **Appendix 9**.

**2.3.2. Inclusion of optional Bank questions**

These questions have been designed by the Advice Centre and the Care Quality Commission and have all been piloted successfully in NHS Trusts. Documents containing the Core and optional Bank questions are available on the Advice Centre website. The optional Bank questions cover:

• WORK-LIFE BALANCE
  o Questions on shift working, reasons for working extra hours, flexible retirement, dependents, care options, and time taken to travel to work).

• TRAINING, LEARNING AND DEVELOPMENT
  o Questions on the number of days training undertaken, protected time for training, and barriers to training.
  o Mental health specific training (included in the Core version of the Mental Health / Learning Disability Trust questionnaire; two additional questions can be also be included as optional questions).

• YOUR JOB AND ORGANISATION
  o Appraisal (training in conducting appraisals).
  o Questions which supplement existing questions in the Core questionnaire on job design, supervisor support and communication, and additional questions on senior management leadership.

• PAY AND CONDITIONS
  o Question on pay and conditions.

• CLINICAL SUPERVISION
  o Questions on experiences of clinical supervision.
• PARTNERSHIP WORKING
  o Questions on working relationships with other non-NHS organisations (these questions can be included as an optional questions in the Mental Health / Learning Disability Trust and PCT versions of the questionnaire).

• ERRORS, NEAR MISSES AND INCIDENTS
  o Questions on whether staff know how to report errors, near misses and incidents and the types of errors, near misses and incidents which could hurt patients.

• VIOLENCE, BULLYING AND HARASSMENT
  o Questions on whether staff know how to violence, bullying and harassment; reasons for not reporting violence, bullying and harassment; and questions on providing a safe environment against violence, bullying and harassment.

• OCCUPATIONAL HEALTH AND SAFETY
  o Questions on advice and support offered to staff and the workplace environment.

• INFECTION CONTROL AND HYGIENE
  o Questions on the promotion of infection control and hygiene (a core question in the Acute Trust version of the Core questionnaire), and cleanliness of the work environment.

• COMMUNICATION
  o Questions on accessing IT and email, and methods of communication used by the Trust.

• BACKGROUND DETAILS
  o Questions about the respondents’ sexual orientation / identity, religious beliefs, contact with patients / service users, bank shifts, employment status, directorate, division, department or location in which the employee works**.

** Although a question is available in the optional Bank to collect information on the directorate / department of each staff member, a much better way of ensuring accurate analysis of results by directorate / department etc is for the Trust to include this variable in the original staff list used at the sampling stage (please see section 2.4 for detailed instructions on how to do this).

The Advice Centre will use directorate / department information on the staff list to present up to two directorate level breakdowns of Trust results in the standard feedback report in late February / early March 2011. We would recommend that this method is chosen, rather than using the optional Bank question. However, the optional Bank question can be used as a fallback option if it proves too difficult for the Trust to include the information on the staff list.

Please note that the precise wording of the optional Bank question about directorate / division / department will need to be amended to suit the local Trust structure. The Questionnaire Compilation Tool on the Advice Centre website enables you to insert the desired question and answer categories (see section 2.3.4 for details). There is space for up to 12 different categories. If this optional directorate / department question is used, it may still be possible for Advice Centre reports to include results by this breakdown. Please ensure that contractors have all relevant information (breakdown used and codes used) to provide to the Advice Centre.
2.3.3. Inclusion of Local questions

Trusts can appoint survey contractors to design additional questions of local interest. These local questions should be of a similar style to that of the Core and optional Bank questions and should be designed on separate pages, but then added to the pages of the PDF generated by the compilation tool, so that all questions can be printed within a single booklet. Decisions about the inclusion of specific local questions should be made, and communicated to survey contractors, by the week beginning 6th September.

Please note that according to the terms of the Ethical Approval granted by MREC North West Board for the National NHS Staff Survey, Trusts are required to submit any additional Local questions for approval by their Trust Management Board. (All Core and optional Bank Questions are already fully ethically approved for use nationally, and do not need to be submitted for further approval in this way. For further details about ethical approval, see section 2.13.)

2.3.4 Creating the questionnaire for your Trust

As in 2008 and 2009, there will be four different versions of the Core questionnaire for each of the four main sectors (Acute, Ambulance, Mental Health / Learning Disability and Primary Care), and a further version of the questionnaire for SHAs and other NHS organisations.

- **Acute Trusts** - should use the Acute Trust version of the Core questionnaire.
- **Acute Specialist Trusts** - should use the Acute Trust version of the Core questionnaire.
- **Ambulance Trusts** - should use the Ambulance Trust version of the Core questionnaire.
- **Care Trusts** - should use either the PCT version of the Core questionnaire or the Mental Health / Learning Disability Trust version of the Core questionnaire depending upon which type of Trust the Care Quality Commission benchmarks these Trusts against. Please see [appendix 11](#) for further details of which version of the Core questionnaire should be used (Trusts are listed by NHS code and name).
- **Mental Health / Learning Disability Trusts** - should use the Mental Health / Learning Disability Trust version of the Core questionnaire.
- **PCTs** - should use the PCT version of the Core questionnaire.
- **PCTs with Mental Health / Learning Disability services** - should use the Mental Health / Learning Disability Trust version of the Core questionnaire. It is the responsibility of PCTs to inform their Approved Contractor if they provide Mental Health and/or Learning Disability services. Please also see [section 2.12](#) on benchmarking groups.
- **Strategic Health Authority** - should use the SHA / other NHS organisation version of the Core questionnaire.
- **Other types of organisation** - should use the SHA / other NHS organisation version of the Core questionnaire.

If you are in any doubt as to which version of the Core questionnaire your Trust should use, please contact the Advice Centre.

The key contacts at each Trust will have already been sent links to a PDF file for each version of the questionnaire. These sample questionnaires should be used for reference only, and are *not* for printing and sending out.
The Compilation Tool on the Advice Centre website (www.nhsstaffsurveys.com) can be used to generate the appropriate version of the Core questionnaire. A username and password (chosen by individual users) need to be entered, to enable identification of each questionnaire, allowing it to be saved and retrieved.

The Compilation Tool can be used to:

- Ensure that the wording in the questionnaire is appropriate for the type of organisation being surveyed. The options available are: “Acute Trust” “Ambulance Trust” “Mental Health / Learning Disability Trust” “Primary Care Trust” or “Strategic Health Authority / other type of organisation”.

- Include the name of an external survey contractor.

- Specify the address to which completed questionnaires must be sent (i.e. the postal address of the survey contractor).

- Specify a telephone helpline number that the survey contractor may have set up to answer staff queries.

- Select optional Bank questions for inclusion in the questionnaire.

Once all the required elements have been selected, the questionnaire can be generated by clicking “Generate PDF”. This produces the questionnaire in a PDF format, which can then be saved on the website, to disk, or printed. It is important to check the questionnaire contains the desired optional Bank questions, and that the instructions on the front cover (in particular return address and helpline number) have been generated correctly.

Typically, creating a questionnaire, including adding any optional Bank questions would be done by the Approved Contractor appointed by the Trust.

2.3.5 Length of the questionnaire

The Core questionnaire is 12 A4 sides in length. If further optional Bank or local questions are added, the questionnaire must be limited to a maximum of 16 A4 sides. A questionnaire that is longer than this will have an adverse effect on response rates.

2.4 Breakdown of results by directorate / department / site

The Trust feedback report produced by the Advice Centre can include up to two breakdowns by directorate, department or location. In order to achieve this, sufficient information needs to be included on the staff lists supplied to contractors in September 2010. Section 2.5 outlines how to prepare a staff list for the survey once Trusts have decided on suitable departmental or directorate breakdowns. Things to consider are outlined below:

1. Each breakdown should have mutually exclusive and comprehensive categories, i.e. each member of staff should be included in one, and only one, of the categories in each breakdown.

2. These categories may be directorates, or departments, or locations, or any similar type of breakdown that is appropriate for the Trust. Examples of the types of breakdowns that Trusts might wish to include are shown below:

   - An Acute Trust spread across a number of locations may wish to have a breakdown of staff responses by location.
- A Mental Health / Learning Disability Trust that has a particular interest in differences between occupational groups (other than those already provided in the questionnaire) may wish to have a breakdown by staff group.

- A PCT with teams of staff based in several locations may wish to have a breakdown by clinical base.

- A care Trust may choose to have a breakdown by directorate; and may also want to compare the responses of staff who are seconded from the local authority, with the responses of other Trust employees.

- Trusts that employ substantial numbers of shared service staff (i.e. staff offering services both to the employing Trust and to other Trusts in the area) may want to have such staff separately identified as a staff group for analysis in the report, so may choose this as one of their breakdowns.

3. If such breakdowns are required in the Advice Centre report, then careful thought needs to be given to the design of the categories to ensure that a large enough number of staff are contained in each category.

The Advice Centre report will focus on the Basic Sample of 850 or fewer staff (see section 2.6.1); and in order to maintain confidentiality for individual staff members, the Advice Centre will not provide feedback on any group from which there are 10 or fewer responses. Therefore, allowing for a 50% response rate, the directorate or department categories should be designed in such a way that there will be a minimum of 20 staff in any one category in the issued Basic Sample.

In general, we would recommend a limit of 12 categories to a breakdown (e.g. 12 directorates, 12 locations). If there are substantially more than this, we would recommend that the Trust combine some of the smaller categories.

Trusts should talk directly to their survey contractors (or the Advice Centre) at an early stage about the precise design of their directorate / department breakdown(s). This will help to ensure that Trusts' later analysis and reporting requirements can be met.

(Please note: there is a limit to the breakdown possible in the Advice Centre report, which will focus on the Basic Sample only, but if the Trust is conducting the survey with a larger staff sample, then more detailed directorate analysis may be possible. Again, Trusts should talk directly to their survey contractors about this when they are preparing their staff lists for the survey.)

4. Once suitable directorate / department categories have been agreed, each member of Trust staff will need to be assigned to an appropriate category.

5. Some Trusts may want their survey contractor to organise separate batches of questionnaires for different sites within the Trust to help with internal distribution. If so, the site needs to be clearly identified on the staff list for each staff member. (In some cases, the site may be the same as directorate / department.) Again, it is recommended that Trusts talk to their survey contractors about how best to identify the site on the staff lists.

6. Information on the directorate / department breakdown required should be sent to the Advice Centre by the survey contractor before the data transfer deadline (no later than 6th December). The Advice Centre will supply each contractor with a template for this information. This will ensure the breakdown of results can be generated on the reports without delay.

Please see section 2.5 for more information about preparation of the staff lists for sampling.
2.5. Preparation for Sampling

2.5.1 Preparation of Staff Lists

One of the first steps in conducting the staff survey is to compile a list of all staff that are eligible to participate. This needs to be carried out by a member of Trust staff who is familiar with both the structure of staff records and the computer programme Microsoft Excel. Please note that preparation of this staff list is the responsibility of the Trust, not of the contractor. We advise that by the week commencing August 23rd, Trusts ensure that staff lists are comprehensive and up to date. This list should include:

- all full time and part-time staff who are directly employed by the Trust on September 1st
- Trust employees on all types of contract:
  - permanent;
  - fixed period;
  - locum;
  - temporary;
  - seconded staff (e.g. social care staff seconded from the local authority), but only if they are on the Trust payroll;
  - hosted staff who have a substantive contract with the Trust.

The list should exclude:

- Staff who are on long-term sick leave or maternity leave on September 1st.
- All staff employed by sub-contracted organisations or outside contractors.
- Bank staff (unless they also have substantive Trust contracts).
- Seconded staff who are on the payroll of another organisation (e.g. social care staff who are on the payroll of the local authority).
- Student nurses.
- Non-executive directors.

Care should be taken to ensure that:

- No eligible staff members have been omitted from the list; (this could potentially happen if, for example, staff records are kept separately for different departments or sites within the Trust).
- The list does not contain duplicate names.
- All ineligible staff have been excluded from the list.
- Records are up to date as of September 1st, including address information.

It should be noted that in previous years, a surprisingly large number of surveys have been sent to staff no longer working for, or not known at, the Trust and to those on long-term sick leave or maternity leave. These surveys can upset the staff who receive them and will cost the Trust both time and money. We urge you to ensure that staff lists are accurate and up-to-date before sampling.

If HR provision is shared between multiple Trusts, then it is important that staff lists are separated in such a way that a separate sample can be drawn for each Trust, not one overall sample for the provision. The staff list for each Trust should be consistent with the instructions above.

---

1 If Trusts want to use the questionnaire to survey some of these excluded groups, they may do so as long as they do not form part of the Basic Sample. To do this, it is recommended that Trusts follow these Guidance Notes to draw the Basic Sample, and then add on other staff groups afterwards. That way, responses from staff groups that are supposed to be excluded from the National Staff Survey will not be fed back to the Advice Centre (this would compromise the comparability of survey results between Trusts). Please note, however, that authorisation should be obtained to survey any employees of external organisations.

2 Usually defined as at least 90 days.
The staff list should be in Excel spreadsheet format, with one employee per row. The first row should be used for column headings (Name, Staff Group, Address etc.) and there should be no blank rows. Each employee should appear only once on the spreadsheet with the following information:

- Full name.
- Sufficient address details (for internal distribution where staff have a permanent work address – this needs to be sufficiently detailed to enable a questionnaire to be sent to each individual via the internal mail. As in previous years, it is permissible to send questionnaires to home addresses of staff who do not have a permanent work address. If this is to be done, home address information for these staff needs to be included in the list. For more information on sending to home addresses, please see section 2.5.2.
- Directorate, department or division (or whatever breakdown or breakdowns are required for the report – see section 2.4).
- Location (if the questionnaires are to be separated into batches for different post rooms – see section 2.10).
- Ethnic background – as in previous years, this information is collected so response rates for different ethnic groups can be monitored. This will enable the Advice Centre and the Care Quality Commission to determine whether there is any bias in responses between different groups of staff. The ethnic background information should be coded using the standard Department of Health ethnic group codes, which can be found in Appendix 10.
- Job title and Staff Group – information on job title and staff group is not essential and it will not be included in the standard Advice Centre report but it would be valuable in monitoring response rates. Information on job title may also be used to help improve the occupational group question in subsequent years.
- PCTs are asked to supply details in the staff list (and Basic Sample) on whether staff members are employed in a ‘provider’, ‘commissioning’ or ‘other’ role (see section 2.5). Employment in a ‘provider’ role includes staff within PCT direct provider organisations that have moved into contractual relationships with their commissioning PCT. Where there are sufficient numbers of respondents, PCTs will be provided with a breakdown of the ‘Key Findings’ for staff employed in ‘provider’, ‘commissioning’ and ‘other’ roles.

For further details on how staff lists should be formatted within Excel, see steps (a) to (c) of the instructions in section 2.6.3.

2.5.2 Use of home addresses – ethical considerations

The use of home addresses is to be used only when the staff member does not have a permanent work place address. If questionnaires are being sent to home addresses, there are three steps that will need to be taken by Trusts to comply with our ethical approval:

1. To ensure there is no invasion of privacy, Trusts should communicate to their workforce that ethical approval has been granted to deliver questionnaires to the home addresses of staff with no permanent work address and that a named person in the Trust is available for staff to contact should they object to this procedure. The named person will then ensure that any objecting staff member’s home address is not included on the sampling database, and internal distribution would then be used for such staff. A template for this communication is included on the Survey Documents page of the Advice Centre website (www.nhsstaffsurveys.com).

2. The letter that accompanies the questionnaire will contain a clause to explain that staff who are unable to be contacted easily at their work base have been sent the questionnaires at their home addresses. A version of this letter can be found in Appendix 1.
3. Any Trust using their external survey contractor for sampling and/or questionnaire distribution, and that wishes to distribute questionnaires to home addresses, should set up a service contract between the Trust and the external contractor. The external contractor must be registered under the Data Protection Act and appropriate steps must be taken to protect employee confidentiality (in the case of the Approved Contractors, these procedures are already in place). A model service contract, with recommended text, can be downloaded from the Survey Documents page on the Advice Centre website (www.nhsstaffsurveys.com).

Please note that questionnaires should not be sent to home addresses of staff who have a work address to which they frequently report.

2.6. Selecting the Staff Sample

It is important that random sampling is used to select the Basic Sample. Random sampling provides a statistically valid way to gather data from a manageable portion of the population. It allows us to take results obtained in the sample and use them as our best estimate of what is true for the relevant population.

Once the staff list has been compiled in Excel, it will need to be passed to the survey contractor or the person in your Trust responsible for sampling, who will then take responsibility for drawing the staff sample.

All Trusts must select a random sample of employees in accordance with the following detailed instructions. This sample is referred to as the Basic Sample throughout these instructions. The size of this Basic Sample will depend on the size of the Trust, as outlined below.

Some Trusts may want to conduct the staff survey with a larger sample than is required, or conduct a Census within the Trust. This is perfectly acceptable. However, please note that in such cases, it is still necessary to randomly select (and later be able to identify) the Basic Sample, according to the instructions below. It is only the data provided by this Basic Sample which will be fed back to the Advice Centre, and will be used by the Advice Centre, the Care Quality Commission and the Department of Health.

2.6.1. Determining the size of the Basic Sample

The size of the Basic Sample is determined by the number of employees in the Trust eligible to receive a questionnaire (i.e. the number of people on the staff list identified in section 2.5.1). This varies in order to guarantee a similar degree of accuracy in the results for all Trusts. The Basic Sample sizes are:

<table>
<thead>
<tr>
<th>Staff eligible to receive questionnaire</th>
<th>Basic Sample size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 600</td>
<td>Census</td>
</tr>
<tr>
<td>601-1000</td>
<td>600</td>
</tr>
<tr>
<td>1001-1500</td>
<td>700</td>
</tr>
<tr>
<td>1501-2000</td>
<td>750</td>
</tr>
<tr>
<td>2001-3000</td>
<td>800</td>
</tr>
<tr>
<td>Over 3000</td>
<td>850</td>
</tr>
</tbody>
</table>
2.6.2 Relative merits of surveying the Basic Sample alone, a larger sample, or a census

The advantages of conducting the survey among the Basic Sample alone are that it keeps costs to a minimum and also limits the burden on staff time. The minimum sample sizes have been designed to ensure that the survey findings will give a statistically representative picture of the views of all staff in the Trust.

If Trusts are considering surveying a larger staff sample, or conducting a census, the advantages would include more detailed sub-group analysis (e.g. more accurate results by directorate or occupational group), and would allow more staff the opportunity to give their opinions. However, the disadvantages are increased costs and increased burden on staff time.

NB. If a Trust surveys more than the Basic Sample, it is very important that the Basic Sample is still selected in the way described below, and that the full specified survey procedures are implemented. It should be remembered that only data from the Basic Sample will be transferred to the Advice Centre, and it is only this data which will be used by the Care Quality Commission.

2.6.3 Selecting a random sample of staff

The following steps give detailed instructions of how to draw a random sample using Excel. For further details about performing general tasks in Excel (such as deleting rows or columns) please see Appendix 5.

a) Row 1 to be used for column headings
The first row should be for column headings, such as “Name”, “Address”, “Site” etc.

b) One employee per row
Each subsequent row (beginning with row 2) should contain the details of one employee. Any blank rows, or rows containing other information (e.g. sub-headings) should be deleted. (See figure 1 for example.)
c) Remove any irrelevant data
Delete any columns containing data irrelevant to the sampling, which will not be of any use later in the process (e.g. pay scale). However, please keep any information about job title or staff group, as this will be very useful in analysing the survey findings, and will also enable organisations to detect any problems with the response rates of particular staff groups during the survey period. Also, information on directorate / department / division / location (as discussed in section 2.4) should be retained throughout.

d) Insert a random number generator column
Go to the first blank column. Give it the heading “Random” by inserting this in the first row. This column will be the random number generator, necessary to do the sampling.

e) Generate first random number
In the second cell of the “Random” column (i.e. the row containing the details of the first employee) enter the text “= rand( )” (without the quotation marks). Press Enter, and this should generate a random number between 0 and 1 (see figure 2).
f) Repeat this random number generation for all cells in that column
The simplest way to do this is to click on the first random number cell, then click on the small black square at the bottom-right corner of the cell. Then drag this down to the last row containing employee details. When the mouse is released, a random number between 0 and 1 is generated for each cell.

g) Sort the data from lowest to highest random number
Return to the top of the list. Highlight all columns by clicking and dragging across the column headers (either letters – A, B, C etc. – or numbers – 1, 2, 3 etc.). Then click on “Data” > “Sort”. Ensure “Header row” is selected. Then use the first drop down menu under “Sort by” to choose the row entitled “Random” (see figure 3). Click OK.
h) Select the staff to participate in the survey
The data should now have sorted itself into a random order. The next stage is to select your staff sample. If there are to be \( x \) employees in the survey, select the first \( x + 1 \) rows (including the column heading row), by dragging over rows 1 to \( x + 1 \).

**Please note here:**
- If you are only planning to survey the Basic Sample, \( x \) will be the minimum sample size, as stipulated in section 2.6.1.
- If you are planning to conduct a survey with a larger sample of staff, then the \( x \) referred to above should be this larger number.
- If a census is desired, you should select all rows.

Copy and paste this information (as appropriate) into a new worksheet. Delete the “Random” column from this new worksheet.

i) Each selected employee to be allocated a unique identification number
In the new worksheet containing only the selected employees, you now need to add ID numbers to the data. Choose the first blank column in the new worksheet. Give it the title “ID Number”. In the first cell of this column (beneath the column heading cell), enter the value “1”. Make a note of the location of this cell: for instance, if it is column G, row 2, the location is G2. If it is column 6, row 2, the location is R2C6.

j) Allocate consecutive ID numbers to each selected employee
In the cell below this, enter the text “= G2 + 1” (without the quotation marks), substituting for G2 if appropriate (see figure 4). This should generate the value “2” when you press enter. Click back on this cell, and click on the small black square at the bottom-right corner of the cell. When released, a sequence of ID numbers from 1 to \( x \) should be generated.
Figure 4: Assigning ID numbers

k) Fix the ID number values, by replicating them in the next column
This stage is very important to ensure that each selected employee is permanently linked to a unique ID number.

Highlight (select) all the ID numbers, along with the column heading. Click on “Edit” > “Copy”. Then click on the first cell to the right of this column (in the first row), and click “Edit” > “Paste Special”. Click on “Values” and “OK”. This will replicate the ID numbers. Delete the original column of ID numbers; these are liable to change if the file is re-sorted.

l) Specify the Basic Sample
The Basic Sample should consist of employees beginning with ID number 1. For instance, if the Basic Sample size is 750, the Basic Sample should comprise ID numbers 1 to 750. As it will be necessary to feed back an anonymised version of the Basic Sample file to the Advice Centre, it is necessary (either at this stage or later) to separate these individuals into a new worksheet.

m) Quality checks on sampling procedure
Before questionnaires are distributed, it is necessary to double-check that the Basic Sample has been selected and identified correctly. Please conduct the following checks on the sample:
- Each member of the Basic Sample has an allocated ID number.
- No ID numbers are duplicated.
- The Basic Sample does not include any staff on long-term sick leave or maternity leave, student nurses, bank staff, staff working for external contractors, non-payroll staff or non-executive directors.
- The sample appears to be in a random order (i.e. it is not structured so that all occupational groups are together, or it is in alphabetical order).
- The proportion of staff in different staff groups or departments (where this information is available) appears appropriate for the Trust – for example, if 50% of a Trust’s employees are nurses, then approximately 50% of the sample should be nurses as well.
n) Retention of staff list and Basic Sample
It is very important to make sure the file has been saved. The Advice Centre carries out some random checks on sampling procedures during October and November. Therefore, it is necessary to keep Excel files containing the original staff list, and the Basic Sample until the end of 2010, in case they are requested by the Advice Centre. The list containing the Basic Sample, including directorate / department information, should be retained for logging of responses by the contractor (if the sampling has been conducted by the Trust, this should be passed to the contractor at this stage).

o) Transfer of sampling information to the Advice Centre
The total number of staff eligible to receive the survey, and the size of the Basic Sample selected, should be e-mailed to the Advice Centre no later than week commencing October 4th. If the sampling was conducted by the Trust, the name and contact details of the person responsible for the sampling in the Trust should be included, in case the Advice Centre have any sampling queries later on. If the sampling was conducted by the survey contractor, contractors should inform the Advice Centre of this.

As in the 2008 and 2009 surveys, Trusts are asked to supply the Advice Centre with details of whether the staff list used to create the Basic Sample has been created using the Electronic Staff Record (ESR) database, and if ESR has been used in which wave the Trust implemented ESR. This information should be supplied to your survey contractor by the end of September at the latest, and then your survey contractor will send this information, along with details of the total number of staff eligible to receive the survey and the size of the Basic Sample selected, to the Advice Centre by week commencing October 4th.

2.7. Pre-survey communication with staff
In September, it is important that Trusts inform staff about the launch of the eighth national staff survey. Research evidence shows that good communication can improve survey response rates. You should try to include the following:

- The purpose of the survey.
- The ways in which survey findings can be used to improve staff's working lives.
- How previous years' survey findings were used within the Trust.
- How and when staff will be receiving a questionnaire.
- How and when staff will get feedback on this year's results.

As mentioned above, it is important to refer to results from the previous staff surveys and to include any action the Trust has taken on the basis of the results. Staff are more motivated to take part in surveys if they can see a tangible outcome from the findings, or if their views are acknowledged through Trust communication. Examples of how Trusts have used the previous results to inform policies include: introducing a “holiday club” to help improve work-life balance, introducing monitoring of appraisals to ensure all staff are appraised, improving staffing levels in areas that are at “high-risk” from violence from patients (such as A&E), introduction of a team-based working policy across the organisation, and adapting work-life balance policies so that they are all-inclusive.

The communication exercise also provides an opportunity to thank staff for taking part in the survey (and for taking part in last year's survey if that has not already been done).

NHS Trusts with the best response rates in previous surveys have used multiple communication methods, including posters, flyers, specialist “National NHS Staff Survey Bulletins”, newsletters and e-bulletins, articles in Trust magazines, and staff briefings. The Trusts with the lowest response rates tended to rely on only one approach.
A successful strategy, used in the past by some Trusts is to distribute the current year’s questionnaire along with the previous year’s survey findings action plan to show how results from previous surveys have been used. Examples of ready-made materials that can be used to publicise the forthcoming staff survey within Trusts and PCTs are available to download from the Advice Centre website (www.nhsstaffsurveys.com) on the Survey Documents page. These include briefing notes for managers, text that can be used in internal bulletins and team briefings, flyers that can be distributed with pay slips, and posters advertising the survey. These examples of materials may be amended to suit local Trust needs.

Please note that it is a requirement under the Data Protection Act 1998 that Trusts inform staff that they are administering a survey.

For more details on the types of communication strategy used in Trusts with high response rates, a separate document, “Methods for improving response rates”, is available on the Advice Centre website (www.nhsstaffsurveys.com) on the Survey Documents page.

2.7.1. The Post Room

Keeping the post room informed about the forthcoming survey is particularly important as the staff there will play a crucial part in the internal distribution of questionnaires and reminders. In previous surveys, there have been delays due to questionnaires getting stuck in post rooms as post room staff were unaware of the importance of the survey timetable. Please see section 2.10 for further information about the survey distribution procedures.

Trusts where the post room staff had been fully briefed by the survey lead in the Trust, and were in ongoing contact with that lead, tended to achieve higher response rates.

The document ‘Methods for improving response rates’, which can be found on the Advice Centre website (www.nhsstaffsurveys.com) on the Survey Documents page, includes a section on advice for communicating with post rooms.

2.8. Boosting response rates

The survey procedures detailed in these Guidance Notes have been designed as far as possible to maximise response rates: clear questionnaire layout, ensuring staff work addresses are up to date for internal questionnaire distribution; targeted reminders; mailing out second copies of the questionnaire to non-respondents; timely publicity of the forthcoming survey; good internal staff communication; telephone helplines for staff; and use of approved contractors experienced in achieving high postal survey response rates.

There are a number of other ways in which Trusts and survey contractors can help to maximise survey response rates. Some of these have been discussed in section 2.7, and all are discussed in detail in the document ‘Methods for improving response rates’, which can be found on the Advice Centre website (www.nhsstaffsurveys.com) on the Survey Documents page. This document is based on the ‘best practice’ of Trusts that achieved the highest response rates in previous staff surveys.

In summary, recommended measures include:

1. Giving the staff survey a high profile within the Trust, both before, during and after the survey (through the use of posters, flyers, emails, staff briefings and so on) – see section 2.7.

2. Explaining clearly to staff the purpose of the survey, how this year’s survey results will be used, what changes were made as a result of the previous staff surveys, and
sending out a clear message that Trust management supports the survey – see section 2.7.

3. Ensuring a smooth internal distribution process for questionnaires and reminders (e.g. through close contact with the post room both before and during the survey period – see section 2.7.1).

4. Identifying "survey champions" within the Trust who can help with monitoring early response rates and look for ways to increase returns from low-responding staff groups and departments.

5. Seeking to get local press coverage for the staff survey, to increase interest and awareness (the Care Quality Commission will be organising a press release about the National Survey in late September / early October, so there should be some coverage in the national press).

6. Allowing staff to complete the questionnaire during working time.

A clear demonstration that senior management support the survey is very important. In previous years, several of the Trusts with the best response rates have included messages from senior management (either included in the survey packs themselves, or communicated via posters, emails or memos).

Another factor that can help response rates is feeding back results, and developing action plans, from previous surveys. In previous years, several of the Trusts with the best response rates have developed action plans, and communicated these with staff before the next survey had begun. It is not enough simply to have developed an action plan however. The important thing is to make sure that staff are aware of this plan – in previous years, although some of the Trusts with the lowest response rates had developed action plans, it was clear that the staff in these Trusts were unaware of this.

**We encourage Trusts to aim for a 60% response rate for the 2010 National NHS Staff Survey.** While there will be no penalties for Trusts not achieving a 60% response rate, it is important that efforts are made to achieve as high a response rate as possible to allow us to have confidence that results reflect the views of staff at your Trust.

The results of your survey may be affected by a number of external events at either the national or local level. For example, your Trust may have recently undergone a merger or other organisational change. It is important to record any such events so that your results can be interpreted in the light of such influences, and when year-on-year comparisons are made, external circumstances may be taken into account.

2.9. Printing of questionnaires, covering letters and reminder cards / letters

2.9.1. Questionnaires

The questionnaire compilation tool described in section 2.3 should be used to create a PDF document containing the Core and any optional Bank questions for a particular Trust. Any local questions should be designed on separate pages, and added to the end of the pages of the PDF document before printing to form a single document.

The questionnaire has been designed in black, white and NHS Light Blue, and should therefore be printed in colour. Experience has shown that the overall look of a questionnaire, including the use of colour, helps to raise survey response rates.
The NHS Light Blue colour used in the questionnaire is Pantone 300, or R:0 G:114 B:198. The light blue used for the bands at the top of each question is a 25% tint of the same colour (Pantone 290 R:196 G:216 B:226).

Questionnaires should be printed as A4 booklets (i.e. a 12-side questionnaire would be 3 folded A3 sheets, stapled in the centre).

All selected staff within a Trust should receive an identical questionnaire, in terms of content and format. The only difference between questionnaires distributed to different individuals should be in the ID number assigned during the sampling procedure (see section 2.6.3). There is an “Office Use Only” box on the front page of the questionnaire for this number to be printed or labelled.

2.9.2. Covering and reminder cards / letters

There are three different types of card / letter, designed for use in the survey:

- A covering letter, which should accompany the questionnaires and a reply-paid envelope (which should be printed with the return address) in the first mailing.
- A first reminder card / letter to be sent to non-respondents three weeks later.
- A second reminder letter, which should accompany a second copy of the questionnaire and another reply-paid envelope sent to non-respondents a further three weeks later.

The text for these three letters has been prepared by the Advice Centre and is downloadable from the Advice Centre website (www.nhsstaffsurveys.com). The text is also given in Appendices 1 to 3.

The Advice Centre has ethical approval for this text. If you make any substantial alterations to the text, you will need to seek the approval of your local Trust Management Board. However, the text allows the insertion of a return address and telephone number for which no additional approval is necessary. It also allows the inclusion or exclusion of a sentence about use of home addresses for questionnaire distribution, where appropriate. The text also includes a sentence giving a number for visually impaired staff to complete their questionnaire verbally over the telephone. All Approved Contractors have agreed to this; if non-approved contractors are able to provide this service then they should insert their own helpline number here, or insert the Advice Centre number.

In addition, this year it is possible to add a short paragraph to explain how the Trust or SHA has used results from previous surveys. This has been shown to help boost response rates.

All letters should be printed on paper headed with the Care Quality Commission logo. On the basis of feedback after the previous surveys, it is recommended that Trust logos are also added to letters – this both assures staff that the Trust is supporting the survey, and provides clarity for any staff working in multiple Trusts about which Trust they should be answering questions about. The Care Quality Commission logo and signature are being sent to Trusts and Approved Contractors with the electronic copy of these guidance notes.

When calculating the number of questionnaires to be printed, you will need to allow for sending out second copies of the questionnaire with the 2nd reminder letters. Printing costs can be unnecessarily high if a second print-run is required, so it is worth ensuring that the first print-run is sufficiently large to allow for contingencies. As a rule of thumb, it is advisable to multiply the number of staff in the sample by 1.7 to obtain the number of questionnaires likely to be required.
It should also be noted that for each questionnaire that is printed, a first class reply-paid envelope will be needed. These envelopes should be printed with the address to which questionnaires are to be returned (i.e. that of the survey contractor).

### 2.9.3. Recycled paper requirements

It is a requirement that all paper used in the publication of the NHS staff surveys, including questionnaires and corresponding letters, must conform to government requirements for the use of 100% recycled paper with a minimum post-consumer waste content of 80%. It is further recommended that the paper used is uncoated and of standard A4 size.

### 2.10. Distribution and receipt of questionnaires, and prompting non-respondents

Survey documents should be distributed to employees with permanent work addresses using the internal post (or other internal distribution mechanisms). Where staff members do not have permanent work addresses, documents may be distributed to home addresses, subject to the procedures described in section 2.5.2 being in place.

Survey contractors may be used to prepare the survey packs, each labelled with a unique ID number, ready for internal distribution by the Trust. It is recognised that many Trusts are based on multiple locations, each with its own post room, and in these cases it is preferable that survey packs be arranged into separate batches for the separate locations. It is the responsibility of Trusts to ensure that contractors have sufficient information (provided with the staff list) to enable them to do this (see section 2.5.1).

The three survey distribution stages are summarised below:

- **Week commencing September 26th**¹ - staff survey packs containing a questionnaire, covering letter and reply-paid envelope, to be distributed to all selected staff (each questionnaire marked with a unique identification number, in order to monitor response and target reminders).

- **Week commencing October 18th**² - reminder letters, to be distributed to selected staff who have not yet returned a questionnaire.

- **Week commencing November 8th**³ - a second reminder letter, accompanied by a second copy of the questionnaire and pre-paid return envelope, to be distributed to selected staff who have still not yet returned a questionnaire.

Printing instructions for the various documents can be found in section 2.9.

As mentioned earlier, the Post Room(s) will play a crucial part in the internal distribution of questionnaires and reminders. It is important therefore to inform the Post Room(s) that their work-load will increase over the survey period, and that they will be the heart of the questionnaire distribution centre. Our previous experience of distributing surveys has shown that it is useful to have the name of a key contact person in (each of) the Post Room(s), and to thank the Post Room staff for the extra work involved.

In particular, the Post Room(s) should be warned in advance of the three distribution stages outlined above. However, the distribution process should not be left to the Post Room staff alone. In previous years, the Trusts with the best response rates had survey leads within the Trusts who took ownership of the distribution process themselves, and kept in close contact

---

¹ or up to three weeks earlier  
² or three weeks after initial mailing  
³ or six weeks after initial mailing
with the Post Room staff, to ensure that distribution went smoothly and according to timetable. In some high response rate Trusts, the survey leads also nominated individuals at each key site or department to take responsibility for ‘receiving’ the packs of questionnaires, and to re-sort questionnaire packs, if necessary, to take account of staff members who had moved to a different department.

*Please note:* We would advise both Trusts and survey contractors to monitor this distribution closely during the survey period. In past surveys, mailing out of the various survey packages has been delayed because Post Room staff were unsure of the distribution timetable.

2.10.1. Taking receipt of completed questionnaires

Each questionnaire should be marked with a return address to which staff should send their completed questionnaires. As mentioned earlier, this should be the address of the external survey contractor. The contractor should log the return of each questionnaire according to its unique ID number and the date when it was received.

At the end of the sampling process (section 2.6), an Excel file containing the names and ID numbers of the sample should have been saved, and passed to the contractor if the sampling was done by the Trust. When a completed questionnaire for a particular ID number is returned, this should be noted on the Excel file by typing “C1”, “C2” or “C3” in the cell immediately to the right of the ID number.

Please use the following codes to record the different types of staff response, against the appropriate ID numbers:

<table>
<thead>
<tr>
<th>Response code</th>
<th>Type of response</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1*</td>
<td>Completed questionnaire returned <strong>before</strong> the respondent received a reminder letter</td>
</tr>
<tr>
<td>C2*</td>
<td>Completed questionnaire returned <strong>after</strong> the respondent received the first reminder letter, but <strong>before</strong> the second reminder letter</td>
</tr>
<tr>
<td>C3*</td>
<td>Completed questionnaire returned <strong>after</strong> the respondent received the second reminder letter</td>
</tr>
<tr>
<td>B</td>
<td>Blank questionnaire returned</td>
</tr>
<tr>
<td>REF</td>
<td>Staff member explicitly opted out / refused to take part</td>
</tr>
<tr>
<td>INEL</td>
<td>Staff member ineligible for survey (e.g. no longer working at the Trust, or not directly employed by the Trust)</td>
</tr>
<tr>
<td>N</td>
<td>Questionnaire not returned (reason not known)</td>
</tr>
</tbody>
</table>

* It is acknowledged that sometimes it may be unclear whether reminder letters had been received before the questionnaire was returned. As a rule of thumb, assume that questionnaires returned up to and including a day after reminder letters have been sent out, were returned **before** the recipient received the reminder.

For staff members who contact the Trust or contractor to explicitly opt out of the survey, or turn out to be ineligible for the survey, no more reminder letters should be sent.
If the ID number has been removed or made illegible, this questionnaire should not be included in the data transferred to the Advice Centre. However, the occurrence should be noted, and the number of questionnaires returned without legible ID numbers should be reported to the Advice Centre with the response rates.

2.10.2. Monitoring response rates, and sending out reminders

This log of questionnaire returns against ID numbers will enable contractors to monitor response rates during the survey period.

For example, it may become apparent using this log, that a particular department has a very low response rate compared with others. If this is the case, it will be worth exploring the reason for the low rate. It might be that distribution in that department has not taken place as planned, or it may be necessary to further publicise and promote the survey within that department. Contractors should ensure that they have systems set up to enable such monitoring.

The log of questionnaire returns against ID numbers should also be used to target reminders at non-responding staff.

First reminder
Three weeks after the questionnaires are distributed; a reminder letter or card must be sent to staff who have not yet returned a questionnaire (i.e. those ID numbers for which no questionnaire has been logged).

Please note that the first reminder should be in a sealed envelope.

Please do not send reminders to staff whose questionnaires have already been logged.

Second reminder
Three weeks after the first reminder letter (six weeks after the initial questionnaire mailing), a further survey pack must be distributed to staff who have still not responded.

This survey pack should contain a reminder letter, a second copy of the questionnaire (marked with each staff member's unique ID number) and a second reply-paid envelope.

Please do not send survey packs to staff whose questionnaires have already been logged.

2.10.3. Informing the Advice Centre of ongoing response rates

Please keep the Advice Centre informed of progress with response rates during the survey period. If the Centre is made aware of problems with response rates at an early stage, Centre staff may be able to offer advice and help in raising the response.

It is the responsibility of survey contractors to inform the Advice Centre of response rates on a weekly basis (every Thursday), from the week commencing October 4th (week two). Please also inform the Advice Centre of the dates that questionnaires and reminder letters were sent out, so that the effect of the reminders can be monitored.
2.10.4. Informing the Advice Centre of advice line queries

Contractors should also keep the Advice Centre informed on a weekly basis of queries received by their advice lines. In addition to the update on response rates each Thursday (during the survey period), contractors should inform the Advice Centre of:

- The types of queries received by the advice line during the previous week (e.g. concerns about confidentiality, unsure how to answer questions).
- The number of each type of query received.

2.11. Data entry and data transfer to the Advice Centre

– instructions for the survey contractor

The deadline for transfer of data to the Advice Centre is Friday 10\textsuperscript{th} December.

This section gives information for contractors about how sample data and data from returned questionnaires should be entered and transferred to the Advice Centre. It is the responsibility of the contractor to enter data from returned questionnaires into Microsoft Excel files (one for Core questions and one for optional Bank questions), and then to return this data to the Advice Centre at Aston University by 10\textsuperscript{th} December.

If it is clear that there will be a delay in transferring the data to the Advice Centre, please alert the Advice Centre at the earliest opportunity. However, in order to meet the analysis and reporting requirements for the Care Quality Commission and Trusts, we need all Trusts to meet the deadlines.

The data to be returned by this date includes:

- The anonymised staff sample file (Excel), containing records of which staff have and have not returned questionnaires.

- Questionnaire data (Excel) files containing data for Core questions, and optional Bank questions, if included. (See section 2.11.2 for details about data entry templates).

- Final response rate should be reported to the Advice Centre along with this data. The response rate is defined as the proportion of questionnaires distributed which are returned completed with clear ID number. However, the number and proportion of:
  - Blank questionnaires returned.
  - Questionnaires returned without legible ID number (if Trust identification is not possible, a total number for all Trusts should be reported).
  - Staff members who explicitly opted out / refused to take part.
  - Staff members who were reported as ineligible for survey should also be reported.

Note that the final Trust response rate may be recalculated by the Advice Centre, to ensure that all response rates are calculated in precisely the same way.
2.11.1. Staff Sample File

This is an Excel file compiled during the sampling and questionnaire receipt stages, as described in sections 2.6 and 2.10. The file should only include members of the Basic Sample and should include:

- ID number.
- Whether or not, and when, they returned a questionnaire (or were ineligible, or refused to take part) – recorded as described in section 2.10.
- Directorate / department etc. of staff (whichever breakdown or breakdowns are being used for the standard Advice Centre feedback report).
- Ethnic group of staff member (coded as described in Appendix 10).
- Job title, if available. This information may be used for refining occupational group categories in future surveys.
- All PCTs are asked to supply details on whether staff members are employed in a ‘provider’, ‘commissioner’ or ‘other’ role – this information should be included in a separate and clearly labelled column in numerical format, where ‘1’ would represent ‘provider’ staff, ‘2’ would represent ‘commissioning’ staff, and ‘3’ would represent ‘other’ staff who provide services to both the provider and commissioning parts of the Trust (e.g. Human Resources) and can not be allocated to either of the ‘provider’ or ‘commissioning’ categories.

This file should be anonymised, i.e. staff names should be removed.

2.11.2. Questionnaire Data File

Data from returned questionnaires must be entered into a fixed, consistent electronic format. It is important that the data are entered exactly as indicated in these instructions; if there are discrepancies then it may lead to mistakes in the data analysis.

The data returned to the Advice Centre should only include members of the Basic Sample. It should also include only data from the Core and optional Bank questions, not Local questions.

Method of data entry
Templates for data entry will shortly be available on the Survey Documents page on the Advice Centre website at (www.nhsstaffsurveys.com). These templates are Microsoft Excel worksheets, containing column headings for each question on the questionnaire – there will be five versions of the data entry templates for each version of the Core questionnaire, plus one generic version of the data entry template for the additional optional Bank questions.

The data from each questionnaire should be entered into a single row on these worksheets. Data from each type of Core questionnaire should be entered onto the corresponding data entry template (e.g. data from an Acute Trust Core questionnaire should ONLY be entered onto the Acute Trust data entry template). Each worksheet should contain a maximum of 10,000 responses, and data should be entered on as few worksheets as possible. Information on how to label an Excel sheet for the different versions of the Core questionnaire data entry templates is discussed in section 2.11.3.

Data may be entered directly into these template worksheets, or may be copied from another worksheet. As the questionnaire templates are structured in such a way that Core questions are listed first, followed by the optional Bank questions, contractors may find it easier to enter the data into another worksheet in questionnaire order and then transfer the Core and optional Bank questions into their respective places in the templates.
Note that the optional Bank questions in the template appear in the same order in which they appear in the Compilation Tool. However, since Trusts are extremely unlikely to use ALL optional Bank questions, there is likely to be some blank space between questions. **Question numbers on this template refer to the version of the optional Bank questions that can be downloaded from the Survey Documents page on the Advice Centre website ([www.nhsstaffsurveys.com](http://www.nhsstaffsurveys.com)).**

Data should mostly be entered as numbers rather than words. The first column is for a Trust ID code and should include the three-letter NHS code of the Trust for which the respondent works.

The ID number of the questionnaire should be entered in the second column. The third column is for the first directorate / department information (coded numerically – i.e. with one number for each category), and the fourth column is for the second breakdown (if used), and the fifth column is for ethnic background (coded as described in Appendix 10). The sixth column should be used for the respondents’ job titles, where these were available from the original staff list (or left blank otherwise). In addition, in the data entry templates for the Mental Health / Learning Disability Trust and PCT Core questionnaires, the seventh column should be used to record details on whether staff members in PCTs are employed in a ‘provider’, ‘commissioning’ or ‘other’ role.

Codes to be entered for the different question options are printed in small type on the questionnaire, adjacent to the relevant tick-boxes. The only exceptions to this are:

- Four questions where respondents have the option to write in an answer – a separate column is provided within the Excel file for this information to be entered (see also later section on data cleaning).

- The general comments box at the end, which should be entered into the final column as text, and in normal sentence case. These should be entered verbatim, except that names of individuals should be removed, and obscenities deleted (or asterisked out). If any other information is given that could lead to identification of the respondent, then these comments should be withheld and not entered.

There are some scenarios when questionnaires do not contain data in the expected format:

- Any questions left unanswered should be left **blank** in the Excel file.

- For most questions requiring a single tick only, if respondents have ticked more than one response at those questions, the data should be treated as missing (i.e. left blank).

- There are a few exceptions to this general rule, and these rules are covered in the section on data cleaning below.

**Data checking**

It is important that the following data entry checks are carried out on the Basic Sample data in each Trust:

- Has the data been entered accurately? (This can be done by double-entering the data from a proportion of questionnaires, or directly comparing the hard-copies of the questionnaires to the entered data; if data are scanned, the latter check is also possible.)

- Has the data been entered in the right columns in the data entry worksheet? (It can be easy to enter the correct data, but in an incorrect column). This is particularly important for optional Bank questions.
For each question, have valid values been entered? (e.g. for a question with answer category values 1-5, check that there are no entered values outside this range.)

Does the file for transfer to the Advice Centre contain all completed questionnaires from the Basic Sample? (Checks should ensure that no data from a Basic Sample staff member have been excluded from the file; and also that all data from non-Basic Sample staff members have been excluded.)

The Advice Centre will conduct some random quality checks on data entry during January 2011. Some randomly selected specific questionnaires (identified by ID number) may be requested from contractors and these will be checked against the data provided. Therefore, it will be necessary to retain all hard copies of questionnaires until at least the end of February 2011.

**Data cleaning**

There are a number of filtered questions in the Core questionnaire. In order to maintain absolute consistency contractors should supply raw data to the Advice Centre on the routed questions. The Advice Centre will then apply a common set of editing instructions.

For the write-in questions, if it is clear from the written response that a different category should have been ticked (e.g. at question 42 in the Acute Trust Core questionnaire¹), if someone writes in “Chinese”, which is a category in its own right), then the response should be changed appropriately.

As mentioned earlier, for most questions requiring a single tick only, if respondents have ticked more than one response for these questions, the data should be treated as missing (i.e. left blank). However, there a few exceptions to this rule:

For the occupational group question in the Acute Trust version of the Core questionnaire (question 46), priority coding should be applied to multiple responses:
- Within the Registered Nurses and Midwives section, prioritise Midwives over Adult / General or Children.
- For other types of multiple responses in the Nurses (Registered) section, re-code as “Other registered nurses”.
- If two occupational groups are ticked, including General Management, prioritise the other occupational group.

For the occupational group question in the Ambulance Trust version of the Core questionnaire (question 47) priority coding should be applied to multiple responses:
- If two occupational groups are ticked, including General Management, prioritise the other occupational group.

For the occupational group question in the Mental Health / Learning Disability Trust version of the Core questionnaire (question 46) priority coding should be applied to multiple responses:
- Within the Registered Nurses and Midwives section, prioritise District / Community over Adult / General, Mental Health, or Learning Disabilities.
- For other types of multiple responses in the Nurses (Registered) section, re-code as “Other registered nurses”.
- If two occupational groups are ticked, including General Management, prioritise the other occupational group.

¹ Question 41 in PCT version of the Core questionnaire and SHA / other NHS organisation Core questionnaire, Question 42 in the Ambulance Trust version of the Core questionnaire and Mental Health / Learning Disability Trust version of the Core questionnaire
For the occupational group question in PCT version of the Core questionnaire (question 45) and the SHA / other NHS organisation version of the Core questionnaire (question 45) priority coding should be applied to multiple responses:

- Within the Registered Nurses and Midwives section, prioritise **Midwife, Health Visitor or District/Community** over **Adult/General, Mental Health, Learning Disabilities or Children**.
- For other types of multiple responses in the Nurses (Registered) section, re-code as “Other registered nurses”.
- If two occupational groups are ticked, including **General Management**, prioritise the other occupational group.

For the question on appraisal (question 8a in all versions of the Core questionnaires except question 9a in the Mental Health / Learning Disability Trust version) then the following should be applied to multiple responses:

- If the respondent ticks **BOTH** “Yes, Knowledge and Skills Framework (KSF) development review” and ‘Yes, other type of appraisal, performance development review or ARCP’ then this should be re-coded as 9.
- If the respondent ticks “Yes, Knowledge and Skills Framework (KSF) development review” **and** ‘No’ then this should be coded as **missing**.
- If the respondent ticks ‘Yes, other type of appraisal, performance development review or ARCP’ **and** “No” then this should be coded as **missing**.

For the questions on the reporting of physical violence (question 28d on the Acute Trust version of the Core questionnaire1), the reporting of harassment, bullying and abuse (question 29c on the Acute Trust version of the Core questionnaire2), and the reporting of errors, near misses and incidents that could hurt staff (question 25b on the Core questionnaire3) or patients / service users (question 26b on the Acute Trust version of the Core questionnaire4) then the following should be applied to multiple responses:

- If the respondent ticks **BOTH** “Yes, I reported it” and “Yes, a colleague reported it” then this should be re-coded as 9.
- If the respondent ticks either “Yes, I reported it” OR “Yes, a colleague reported it” and also “Don’t know” then prioritise the “Yes, I reported it” OR “Yes, a colleague reported it”.
- If the respondent ticks either “Yes, I reported it” OR “Yes, a colleague reported it” and also “No” then this should be coded as **missing**.

### 2.11.3. When the data have been entered

If a contractor is returning data from only one Trust, please save the staff list Excel file as the three-letter NHS code of the organisation from which the data came, appended by “sample”, so that it can easily be identified by the Advice Centre. For example, for a Trust with NHS code AAA this would be “AAA sample.xls”. For data returns please save the Excel file with the three-letter NHS code of the organisation from which the data came, appended by the version of the Core questionnaire used (e.g. acute, ambulance, mental health & learning disability, mental health & learning disability, mental health & learning disability).

---

1 Question 28d in PCT version of the Core questionnaire and SHA / other NHS organisation version of the Core questionnaire, and Question 29d in the Ambulance Trust version of the Core questionnaire and Mental Health / Learning Disability Trust version of the Core questionnaire
2 Question 29c in PCT version of the Core questionnaire and SHA / other NHS organisation version of the Core questionnaire, and Question 30c in the Ambulance Trust version of the Core questionnaire and Mental Health / Learning Disability Trust version of the Core questionnaire
3 Question 25b in PCT version of the Core questionnaire and SHA / other NHS organisation version of the Core questionnaire, and Question 26b in the Ambulance Trust Core version of the questionnaire and Mental Health / Learning Disability Trust Core version of the questionnaire
4 Question 26b in PCT version of the Core questionnaire and SHA / other NHS organisation version of the Core questionnaire, and Question 27b in the Ambulance Trust version of the Core questionnaire and Mental Health / Learning Disability Trust version of the Core questionnaire
PCT or other) and “data”. For example, data from an Acute Trust with NHS code AAA would be “AAA acute data.xls”.

If a contractor is returning data from more than one Trust in the same worksheet, please save the staff list Excel file with the name of the contractor, appended by “sample” and also a unique number to differentiate between worksheets if submitting multiple Excel files e.g. “Contractor x sample1.xls”; “Contractor x sample2.xls” etc. For questionnaire data returns please save the Excel file with the name of the contractor, appended by the type of Core questionnaire used (e.g. acute, ambulance, mental health & learning disability, PCT or other), “data” and a unique number to differentiate between worksheets if submitting multiple Excel files. For example, data submitted from the same contractor from more than one Acute Trust and in multiple Excel files would be “contractor x acute data1.xls”, “contractor x acute data2.xls” etc.

**If you are in any doubt about naming of files please contact the Advice Centre.**

All files must also be password protected, with the password being assigned by the contractor and sent to the Advice Centre in a separate e-mail.

**2.11.4. Transferring the data**

Data should be returned to the Advice Centre using secure data transfer. The Advice Centre will contact each contractor in week commencing 30th November 2010 to confirm how the data files should be transferred.

In addition to the transfer of the data files, contractors are required to supply the Advice Centre with an Excel file containing the following information:

- The total number of eligible staff at each Trust.
- The number of staff in the Basic Sample at each Trust.
- The total number of Basic Sample completed questionnaires received at each Trust at each stage of the survey - C1, C2 and C3 (see section 2.10.1).
- The number of blank questionnaires returned for each Trust.
- The number of ineligible staff contacted for each Trust.
- The overall response rate for the Basic Sample at each Trust.

This information should be returned via email to the Advice Centre (m.r.carter@aston.ac.uk), and the email should also contain details of:

- The number of questionnaires returned with ID number removed (overall – obviously not possible for each Trust).
- The overall number of questionnaires checked and errors found.
2.12. Reports of the survey findings

The Advice Centre will provide a feedback report on the survey results for each Trust. This will include analysis of the survey results on a number of key findings where Trusts scores are benchmarked against data collected from other Trusts of a similar Trust type. The reports will include several breakdowns of the results on these key areas within Trusts (on a range of demographic factors such as occupational group, age, gender, ethnic background and organisational tenure etc.) and also a detailed breakdown of responses to all of the questions included in the Core questionnaire. Examples of Trust feedback reports from previous years can be found on the Care Quality Commission website at: www.cqc.org.uk/aboutcqc/howwedoit/engagingwithproviders/nhsstaffsurveys.cfm.

In previous years there have been six benchmarking groups used in the Trust feedback reports; these being:

- Acute Trusts
- Acute Specialist Trusts
- Ambulance Trusts
- Mental Health and Learning Disability Trusts
- Primary Care Trusts (PCTs)
- PCTs with Mental Health and Learning Disability Services

Similar categories will be used again for the 2010 survey; however, with the organisational changes occurring with PCTs in light of Transforming Community Services, we are proposing to slightly alter the PCTs benchmarking groups. For the 2010 staff survey we propose the following groups:

- Commissioning PCTs (i.e. PCTs which only have a commissioning function)
- General PCTs (i.e. PCTs with both provider and commissioning functions)
- PCTs with Mental Health and Learning Disability Services (i.e. General PCTs which also have a Mental Health and Learning Disability provision)

It is the responsibility of PCTs, via their survey contractor, to confirm which benchmarking group they consider best reflects their PCT at the time of the 2010 staff survey. This should be done by the end of September, and then your survey contractor will send this information to the Advice Centre by week commencing October 4th. This information will then be used for benchmarking purposes when the Trust feedback reports are produced.

The Trust feedback reports will be made available via ‘early view’ to Trusts in late February / early March 2011, and then published on the Care Quality Commission website (www.cqc.org.uk/aboutcqc/howwedoit/engagingwithproviders/nhsstaffsurveys.cfm) in late March 2011. We should stress that until the results are published on the Care Quality Commission website, there is an embargo on the publication of any 2010 survey results which use the benchmarked analysis included in the Trust feedback reports.

As soon as the Trust feedback report of the 2010 staff survey has been published on the Care Quality Commission website, staff should be informed about how they can access the results. This will show staff that their contribution is valued, and will help response rates in future surveys (see section 2.8 for further information).

Some Trusts may want to commission additional analysis of their own data (which could include directorate breakdowns), or early analysis of the Trust level data, before the Advice Centre feedback reports are published. This must be negotiated separately with their survey contractors.
Trusts can use data supplied by their approved contractor to start developing action plans or for internal purposes. However, the feedback reports produced by the Advice Centre are benchmarked against other Trusts of a similar type – accordingly, in order to make fair comparison between Trusts in the feedback reports, the data from each Trust will be weighted so that the occupational group profile of that Trust reflects that of a typical Trust of its type. This means that it is possible that results given in the feedback reports produced by the Advice Centre could differ slightly from those given in any earlier reports produced by survey contractors, even if only the Basic Sample was analysed in those cases. Hence, we ask that Trusts do not release staff survey findings externally e.g. local media until the results are published on the Care Quality Commission website in late March 2011.

2.13. Ethical considerations

Aston University have been awarded ethical approval for the ongoing development of the National Staff Survey by the MREC North West Board. This approval, which covers staff surveys for the 2010 survey, covers all survey procedures and the wording of the Core and optional Bank questions.

For Trusts using only the Core and optional Bank questions there is therefore no need for them to apply for further local ethical approval.

However, if Trusts wish to include additional local questions in the 2010 survey, they are required to submit these for approval to their Trust Management Board. (No application to the local LREC board is necessary.)

Trusts are required by the 1998 Data Protection Act to inform their staff that they are being surveyed. Trusts are at liberty to choose the most appropriate forms of communication for their Trust to enact this request.

The Advice Centre is aware of the ethical implications of handling and storing sensitive data. Space has been allocated to ensure that data will be stored in locked accommodation. The data will be analysed on secure IT equipment that has strict password entry. The Advice Centre is ultimately responsible to Aston University for the handling of sensitive data.
Appendix 1

Text of covering letter sent with first questionnaire

[Sections in brackets are to be completed according to each Trust's/contractor's needs]

Dear Colleague,

National NHS Staff Survey

We are writing to ask you to take part in the 2010 National NHS Staff Survey which asks for your views on your job and the trust in which you work. [Trust name] will be able to use the findings of the survey to improve the working conditions and the experience of staff in your trust. We are conducting this survey in all NHS trusts in England as it is an important way of ensuring that the views of NHS employees inform local improvements and national policies.

The survey is being administered by [contractor name] on behalf of your NHS trust and the Care Quality Commission. [Your name was selected at random from a list of all staff working for your trust.] [Please note that some staff who do not frequently report to a permanent work address may have received a questionnaire at their home address.]

[A SHORT PARAGRAPH MAY BE ADDED HERE TO SHOW HOW RESULTS FROM PREVIOUS SURVEYS HAVE BEEN USED IN THIS TRUST.]

Responses to this survey are strictly confidential. Nobody from your trust will see your completed questionnaire, or be able to identify individual responses. Your personal data will be held in accordance with the Data Protection Act 1998, and the principles of the NHS Confidentiality Code of Practice. All personal information relating to this survey will be destroyed within three months of its completion.

[Contractor], Aston University and the Care Quality Commission will produce anonymous statistics, from which no individual's responses can be identified, for each NHS trust taking part in the survey.

We would be grateful if you could return your completed questionnaire to [insert return address]. If you are blind or visually impaired, you may complete the questionnaire over the telephone, by calling the [Contractor name and number] or the helpline on 0121 204 3131.

If you have any questions or comments about this survey, you can find out more at www.nhsstaffsurveys.com or by calling the helpline number above.

Thank you for your help with this important survey.

Yours sincerely,

Katerina Vardulaki
NHS Staff Survey Manager
Care Quality Commission

[TRUST CHIEF EXECUTIVE'S SIGNATURE MAY ALSO BE ADDED]
Appendix 2

Text of first reminder letter
[Sections in brackets are to be completed according to each Trust’s/contractor’s needs]

Dear Colleague,

National NHS Staff Survey

We recently invited you to take part in a survey about working in the NHS. [Your name was selected at random from a list of all staff working for your trust.]

If you have not yet completed the questionnaire, please do so today and return it to [contractor name and address here]. We can only help the NHS to improve as an employer by gathering the views of as many staff as possible and monitoring their experiences over time.

If you have already completed and returned the questionnaire, we thank you and apologise for this reminder. If you have not received a copy of the questionnaire, or have any queries, please contact [Contractor name] on [Contractor number].

Thank you for participating in this important survey.

Yours sincerely,

Katerina Vardulaki
NHS Staff Survey Manager
Care Quality Commission
[TRUST CHIEF EXECUTIVE’S SIGNATURE MAY ALSO BE ADDED]
Dear Colleague,

National NHS Staff Survey

[In late September / early October], we invited you to take part in a survey about your experience of working in the NHS. Many people/colleagues have already completed and returned this questionnaire, and we thank you if you have already done so.

The annual NHS staff survey is an important way of ensuring that the views and experiences of NHS employees help to shape local improvements and national workforce policy. If you have not yet returned your survey, we urge you to do so. We can only be sure that results are representative of the NHS as a whole if we hear from a large proportion of those asked to participate.

[A SHORT PARAGRAPH MAY BE ADDED HERE TO SHOW HOW RESULTS FROM PREVIOUS SURVEYS HAVE BEEN USED IN THIS TRUST.]

We would like to reassure you that reports of individual survey data will include summary information only from which no individual’s data can be identified. We have enclosed another questionnaire in case you have mislaid the original and hope that you will complete and return it.

Thank you for your help.

Yours sincerely,

Katerina Vardulaki
NHS Staff Survey Manager
Care Quality Commission

[TRUST CHIEF EXECUTIVE’S SIGNATURE MAY ALSO BE ADDED]
### Appendix 4

**Summary of information to be transferred to the Advice Centre**

<table>
<thead>
<tr>
<th>Document/Information</th>
<th>How returned</th>
<th>By when</th>
<th>By whom</th>
<th>Where in guidance notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name/contact details of two people responsible for the survey in the Trust</td>
<td>E-mail</td>
<td>As soon as possible</td>
<td>Trust</td>
<td>Section 2.1</td>
</tr>
<tr>
<td>Details of whether the Trust used Electronic Staff Record database to create the staff list</td>
<td>E-mail</td>
<td>By October 8th</td>
<td>Trust and contractor</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Number of staff in Trust eligible to receive questionnaires and size of the Basic Sample</td>
<td>E-mail</td>
<td>By October 8th</td>
<td>Trust and contractor</td>
<td>Section 2.5 / 2.6</td>
</tr>
<tr>
<td>Name and contact details of person responsible for sampling</td>
<td>E-mail</td>
<td>By October 8th</td>
<td>Trust and contractor</td>
<td>Section 2.6</td>
</tr>
<tr>
<td>Confirm benchmarking groups to be used for feedback reports</td>
<td>E-mail</td>
<td>By October 8th</td>
<td>Trust and contractor</td>
<td>Section 2.12</td>
</tr>
<tr>
<td>Response rates during the survey period, dates of questionnaire and reminder mailings, and summary of queries to advice line</td>
<td>E-mail</td>
<td>Weekly after questionnaires are sent out</td>
<td>Contractor</td>
<td>Section 2.10</td>
</tr>
<tr>
<td>Details of directorate etc. breakdown</td>
<td>E-mail</td>
<td>By December 6th</td>
<td>Contractor</td>
<td>Section 2.4</td>
</tr>
<tr>
<td>Data documents (Staff sample file, Questionnaire data file)</td>
<td>By secure FTP transfer</td>
<td>By December 10th</td>
<td>Contractor</td>
<td>Section 2.11</td>
</tr>
<tr>
<td>Other information – final response rate &amp; number of completed questionnaires received, number of blank questionnaires returned, number of questionnaires returned with ID number removed, number of ineligible staff contacted, number of questionnaires checked, number of errors found, password for data files</td>
<td>E-mail</td>
<td>By December 10th</td>
<td>Contractor</td>
<td>Section 2.11</td>
</tr>
<tr>
<td>Questionnaires for data checking</td>
<td>By post (recorded delivery) or digital image (secure FTP transfer)</td>
<td>On request from Advice Centre</td>
<td>Contractor</td>
<td>Section 2.10</td>
</tr>
<tr>
<td>Staff list and sample from selected Trusts</td>
<td>Secure FTP transfer</td>
<td>On request from Advice Centre</td>
<td>Trust or contractor</td>
<td>Section 2.5 / 2.6</td>
</tr>
</tbody>
</table>
Appendix 5

How to select a random sample in Excel

(a) **Inserting a blank first row**
Click on the top left hand cell (usually ‘A1’ or ‘R1C1’) and then “Insert” > “Rows”. This should insert a blank row, which can be used for headings.

(b) **Deleting rows**
To delete a row, highlight it by clicking on the row number at the extreme left-hand end of the row, and click on “Edit” > “Delete”.

(c) **Deleting columns**
Deleting a column is done in the same way as deleting rows (see b).

(d) **Selecting multiple rows**
Place the mouse pointer over the row number of the first row you wish to select (on the far left hand side of the worksheet). Click and drag down to the row number of the last row you wish to select. When the mouse is released, these rows should then be highlighted.

(e) **Copying and pasting multiple rows into a new worksheet**
When rows are selected, click on “Edit” > “Copy”. Open a new worksheet by clicking “File” > “New”. Paste in the rows by clicking “Edit” > “Paste”.

**Changing the cell reference style from ‘R1C1’ to ‘A1’**
Some operations are easier to carry out with the ‘A1’ style of cell reference, rather than the ‘R1C1’. To change this, click on “Tools” > “Options”, then the “General” tab, and uncheck “R1C1 reference style”.

**Password protecting files**
To make sure that a file can only be accessed by someone who knows a password, click on “File” > “Save As”. Then click on “Tools” > “General Options”. Enter a password which will protect the file before saving it.
Appendix 6

Contact Details of Approved Contractors

CAPITA Health Service Partners
Contact: Cheryl Kershaw / Aimi Blueman
Telephone: 01423 720212
e-mail: cheryl.kershaw@capita.co.uk / aimi.blueman@capita.co.uk

Picker Institute Europe
Contact: Jenny King / Stephen Bough
Telephone: 01865 208130 / 01865 208163
e-mail: jenny.king@pickereurope.ac.uk / stephen.bough@pickereurope.ac.uk

Quality Health
Contact: Reg Race / Mandy Moore / Kerry Hibberd
Telephone: 01246 856263
e-mail: reg.race@quality-health.co.uk / mandy.moore@quality-health.co.uk / kerry.hibberd@quality-health.co.uk
## Appendix 7

### Questions that map to the Health and Safety Executive Management Standards

Most of the questions in the National NHS Staff Survey 2010 are directly relevant to the Health and Safety Executive's (HSE) Management Standards. Details of the questions which map onto the HSE Management Standards can be found in the following table.

<table>
<thead>
<tr>
<th>Question text</th>
<th>Question number(s) in the different versions of the 2010 Core questionnaire</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control I can decide on my own how to go about doing my work</td>
<td>14f 14f 15f 14f 14f</td>
</tr>
<tr>
<td>Role I have clear, planned goals and objectives for my job</td>
<td>11a 11a 12a 11a 11a</td>
</tr>
<tr>
<td>Relationships In the last 12 months have you personally experienced harassment, bullying or abuse at work from your manager / team leader or other colleagues</td>
<td>29b 30b 30b 29b 29b</td>
</tr>
<tr>
<td>Relationships Relationships at work are strained</td>
<td>14e 14e 15e 14e 14e</td>
</tr>
<tr>
<td>Demands I cannot meet all the conflicting demands on my time at work</td>
<td>11d 11d 12d 11d 11d</td>
</tr>
<tr>
<td>Demands I have adequate materials, supplies and equipment to do my work</td>
<td>11e 11e 12e 11e 11e</td>
</tr>
<tr>
<td>Demands There is enough staff at this Trust for me to do my job properly</td>
<td>11f 11f 12f 11f 11f</td>
</tr>
<tr>
<td>Demands I do not have time to carry out all my work</td>
<td>14c 14c 15c 14c 14c</td>
</tr>
<tr>
<td>Change I am consulted about changes that affect my work area / team / department</td>
<td>14b 14b 15b 14b 14b</td>
</tr>
<tr>
<td>Support I am satisfied with the support I get from my work colleagues</td>
<td>13d 13d 14d 13d 13d</td>
</tr>
<tr>
<td>Support I am satisfied with the support I get from my immediate manager</td>
<td>13b 13b 14b 13b 13b</td>
</tr>
</tbody>
</table>
## Appendix 8

**Questions that can be used by trusts to continue monitoring against the Improving Working Lives (IWL) standard**

Most of the questions in the National NHS Staff Survey 2010 are directly relevant to Improving Working Lives. Although IWL is no longer monitored by the Department of Health, its principles are core to good human resource management. The following table takes each of the six areas of good practice, as listed in the IWL Standard (2000) and referred to in the IWL Practice Plus National Audit Instrument, and lists the precise core survey questions that are relevant to each area. Some questions and scores are relevant to more than one area of good practice. There are a number of additional questions available in the optional Bank, which are also relevant to Improving Working Lives. All the optional Bank questions can be downloaded from the Advice Centre website ([www.nhsstaffsurveys.com](http://www.nhsstaffsurveys.com)).

<table>
<thead>
<tr>
<th>IWL area</th>
<th>Content of question</th>
<th>Question number(s) in 2010 version of the Core questionnaire</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>acute</td>
</tr>
<tr>
<td><strong>HR Strategy &amp; Management</strong></td>
<td>management and supervision</td>
<td>7a-e</td>
</tr>
<tr>
<td></td>
<td>appraisal</td>
<td>8a-d</td>
</tr>
<tr>
<td></td>
<td>personal development plans</td>
<td>9a-c</td>
</tr>
<tr>
<td></td>
<td>team working</td>
<td>10a-d</td>
</tr>
<tr>
<td></td>
<td>intention to leave the job</td>
<td>12a-c</td>
</tr>
<tr>
<td><strong>Equality &amp; Diversity</strong></td>
<td>training in equality and diversity</td>
<td>5a</td>
</tr>
<tr>
<td></td>
<td>management and supervision</td>
<td>7a-e</td>
</tr>
<tr>
<td></td>
<td>satisfaction with various aspects of job</td>
<td>13a-h</td>
</tr>
<tr>
<td></td>
<td>equal opportunities</td>
<td>17, 18a-c</td>
</tr>
<tr>
<td></td>
<td>ethnic background, disability, occupational group</td>
<td>41, 42, 46</td>
</tr>
<tr>
<td><strong>Staff Involvement &amp; Communication</strong></td>
<td>management and supervision</td>
<td>7a-e</td>
</tr>
<tr>
<td></td>
<td>clear job content</td>
<td>11a, 14a</td>
</tr>
<tr>
<td></td>
<td>feedback</td>
<td>11b, 13a, 14d</td>
</tr>
<tr>
<td>IWL area</td>
<td>Content of question</td>
<td>Question number(s) in 2010 version of the Core questionnaire</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Staff Involvement &amp; Communication</td>
<td>staff involvement</td>
<td>11c, 14b</td>
</tr>
<tr>
<td></td>
<td>views about the way the organisation is run</td>
<td>16a-e</td>
</tr>
<tr>
<td>Flexible Working</td>
<td>employer's attitude towards work life balance</td>
<td>2a-c</td>
</tr>
<tr>
<td></td>
<td>flexible working options</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>working additional hours</td>
<td>1b-c</td>
</tr>
<tr>
<td></td>
<td>training in health &amp; safety related areas</td>
<td>5b</td>
</tr>
<tr>
<td></td>
<td>raising concerns at work</td>
<td>19a-c</td>
</tr>
<tr>
<td></td>
<td>witnessing and reporting errors and near misses</td>
<td>25a-b, 26a-b</td>
</tr>
<tr>
<td></td>
<td>incident reporting</td>
<td>27a-g</td>
</tr>
<tr>
<td></td>
<td>experiencing physical violence</td>
<td>28a-b</td>
</tr>
<tr>
<td></td>
<td>experiencing harassment, bullying or abuse</td>
<td>29a-b</td>
</tr>
<tr>
<td></td>
<td>reporting violence or harassment, bullying or abuse</td>
<td>28d, 29c</td>
</tr>
<tr>
<td></td>
<td>views about employer's effective action towards violence and harassment</td>
<td>30a-d</td>
</tr>
<tr>
<td></td>
<td>access to counselling and occupational health services</td>
<td>31a-b</td>
</tr>
<tr>
<td></td>
<td>work-related injuries or sickness</td>
<td>32a-e</td>
</tr>
<tr>
<td></td>
<td>availability of hot water, soap, towels &amp; alcohol rubs</td>
<td>33a-c</td>
</tr>
<tr>
<td></td>
<td>promoting infection control and hygiene</td>
<td>34a-c</td>
</tr>
<tr>
<td>Healthy Workplace</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>types of training</td>
<td>4a-g</td>
</tr>
<tr>
<td></td>
<td>training in specific areas</td>
<td>5a-i</td>
</tr>
<tr>
<td></td>
<td>benefits of training</td>
<td>6a-c</td>
</tr>
<tr>
<td></td>
<td>equal access to career progression &amp; development</td>
<td>17</td>
</tr>
<tr>
<td>Training &amp; Development</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>12c, 15b</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>18</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17</td>
</tr>
</tbody>
</table>
Appendix 9

Changes to questions in the 2010 Core Questionnaire

A number of changes have been made to the Core questionnaire since the 2009 survey, and these can be seen in the tables below.

<table>
<thead>
<tr>
<th>Questions dropped</th>
<th>Question number(s) in 2009 version of the Core questionnaire</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question ‘Do you work rotating shifts?’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>1a 1a 1a 1a 1a</td>
</tr>
<tr>
<td>Question ‘Do your working hours include any time between 7pm and 7am?’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>1b 1b 1b 1b 1b</td>
</tr>
<tr>
<td>Question ‘How many core members are there in your team?’ dropped from the core questionnaire and moved to the optional Bank questions.</td>
<td>10e 10e 11e 10e 10e</td>
</tr>
<tr>
<td>Question ‘I have an interesting job’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>19e 20e 20e 19e 19e</td>
</tr>
<tr>
<td>Question ‘My Trust communicates clearly with staff about what it is trying to achieve’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>20a 21a 21a 20a 20a</td>
</tr>
<tr>
<td>Question ‘I know how my role contributes to that my Trust is trying to achieve’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>20b 21b 21b 20b 20b</td>
</tr>
<tr>
<td>Question ‘I know how my Trust contributes to what the NHS is trying to achieve’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>20c 21c 21c 20c 20c</td>
</tr>
<tr>
<td>Question ‘I understand the national vision for the NHS’ dropped from the core questionnaire and moved to optional Bank questions.</td>
<td>20d 21d 21d 20d 20d</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New questions added</th>
<th>Question number(s) in 2010 version of the Core questionnaire</th>
</tr>
</thead>
<tbody>
<tr>
<td>New question ‘How to deliver a good patient/service user experience (e.g. monitor the patient/service user experience, and use the feedback to make improvements)’ added to the core questionnaire.</td>
<td>5i 5i 5i 5i 5i</td>
</tr>
<tr>
<td>Changes to existing questions</td>
<td>Question number(s) in 2010 version of the Core questionnaire</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Response options on the ‘flexible working options’ questions changed from seven ‘Yes / No’</td>
<td>急性</td>
</tr>
<tr>
<td>questions to one ‘tick all that apply’ question.</td>
<td>3</td>
</tr>
<tr>
<td>Wording and response options on the ‘team-based working’ questions changed from three</td>
<td>10b-d</td>
</tr>
<tr>
<td>‘Yes / No’ questions ‘b. Does your team have clear objectives’, ‘c. Do you have to work</td>
<td></td>
</tr>
<tr>
<td>closely with other team members to achieve the team’s objectives?’, and ‘d. Does the team</td>
<td></td>
</tr>
<tr>
<td>meet regularly and discuss its effectiveness and how it could be improved?’ to ‘b. Team</td>
<td></td>
</tr>
<tr>
<td>members have a set of shared objectives’, ‘c. Team members often meet to discuss the team’s</td>
<td></td>
</tr>
<tr>
<td>effectiveness’, and ‘d. Team members have to communicate closely with each other to achieve</td>
<td></td>
</tr>
<tr>
<td>the team’s objectives’. Each question is answered on a five point ‘Strongly disagree’ to ‘</td>
<td></td>
</tr>
<tr>
<td>‘Strongly agree’ scale.</td>
<td></td>
</tr>
<tr>
<td>Response options on the ‘discrimination’ question changed from a single ‘Yes / No’ question</td>
<td>18a-b</td>
</tr>
<tr>
<td>to two response options ‘a. patients / service users, their relatives or other members of the</td>
<td></td>
</tr>
<tr>
<td>public’ and ‘b. manager / team leader or other colleagues’ to identify the source of the</td>
<td></td>
</tr>
<tr>
<td>discrimination.</td>
<td></td>
</tr>
<tr>
<td>Wording of the ‘raising concerns at work’ questions changed from ‘a. If you were concerned</td>
<td>19a-c</td>
</tr>
<tr>
<td>about negligence or wrongdoing by staff in this Trust, would you know how to report your</td>
<td></td>
</tr>
<tr>
<td>concerns?’ and ‘b. Is there a system to report such concerns confidentially?’ to ‘a. If you</td>
<td></td>
</tr>
<tr>
<td>were concerned about fraud, malpractice or wrongdoing would you know how to report it?’,</td>
<td></td>
</tr>
<tr>
<td>‘b. Would you feel safe raising your concern?’, and ‘c. Would you feel confident that your</td>
<td></td>
</tr>
<tr>
<td>Trust would address your concern?’</td>
<td></td>
</tr>
<tr>
<td>Response options on the ‘physical violence at work’ question collapsed from five ‘Yes / No’</td>
<td>28a-b</td>
</tr>
<tr>
<td>questions ‘a. patients / service users’, ‘b. relatives of patients / service users’, ‘c.</td>
<td></td>
</tr>
<tr>
<td>other members of the public’, ‘d. manager / team leader’, and ‘e. other colleagues’ into two</td>
<td></td>
</tr>
<tr>
<td>‘Yes / No’ questions ‘a. patients / service users, their relatives or other members of the</td>
<td></td>
</tr>
<tr>
<td>public’ and ‘b. manager / team leader or other colleagues’.</td>
<td></td>
</tr>
<tr>
<td>Response options on the ‘harassment, bullying and abuse at work’ question collapsed from five</td>
<td>29a-b</td>
</tr>
<tr>
<td>‘Yes / No’ questions ‘a. patients / service users’, ‘b. relatives of patients / service users’,</td>
<td></td>
</tr>
<tr>
<td>‘c. other members of the public’, ‘d. manager / team leader’, and ‘e. other colleagues’ into</td>
<td></td>
</tr>
<tr>
<td>two ‘Yes / No’ questions ‘a. patients / service users, their relatives or other members of the</td>
<td></td>
</tr>
<tr>
<td>public’ and ‘b. manager / team leader or other colleagues’.</td>
<td></td>
</tr>
</tbody>
</table>
### Appendix 10

**Ethnic Background codes to be included in staff list**

<table>
<thead>
<tr>
<th>Ethnic Origin</th>
<th>Code to be included in staff list</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>White</strong></td>
<td></td>
</tr>
<tr>
<td>White British</td>
<td>A</td>
</tr>
<tr>
<td>White Irish</td>
<td>B</td>
</tr>
<tr>
<td>Any other White background</td>
<td>C</td>
</tr>
<tr>
<td><strong>Mixed</strong></td>
<td></td>
</tr>
<tr>
<td>White &amp; Black Caribbean</td>
<td>D</td>
</tr>
<tr>
<td>White &amp; Black African</td>
<td>E</td>
</tr>
<tr>
<td>White &amp; Asian</td>
<td>F</td>
</tr>
<tr>
<td>Any other mixed background</td>
<td>G</td>
</tr>
<tr>
<td><strong>Asian or Asian British</strong></td>
<td></td>
</tr>
<tr>
<td>Indian</td>
<td>H</td>
</tr>
<tr>
<td>Pakistani</td>
<td>J</td>
</tr>
<tr>
<td>Bangladeshi</td>
<td>K</td>
</tr>
<tr>
<td>Any other Asian background</td>
<td>L</td>
</tr>
<tr>
<td><strong>Black or Black British</strong></td>
<td></td>
</tr>
<tr>
<td>Caribbean</td>
<td>M</td>
</tr>
<tr>
<td>African</td>
<td>N</td>
</tr>
<tr>
<td>Any other Black background</td>
<td>P</td>
</tr>
<tr>
<td><strong>Other ethnic groups</strong></td>
<td></td>
</tr>
<tr>
<td>Chinese</td>
<td>R</td>
</tr>
<tr>
<td>Any other ethnic background</td>
<td>S</td>
</tr>
<tr>
<td>Not stated</td>
<td>Z</td>
</tr>
</tbody>
</table>
### Appendix 11

**List of Care Trusts and version of questionnaire to be used**

<table>
<thead>
<tr>
<th>NHS Code</th>
<th>Trust Name</th>
<th>Questionnaire to be used</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAC</td>
<td>Northumberland Care Trust</td>
<td>PCT</td>
</tr>
<tr>
<td>TAD</td>
<td>Bradford District Care Trust</td>
<td>Mental Health / Learning Disability Trust</td>
</tr>
<tr>
<td>TAE</td>
<td>Manchester Mental Health and Social Care Trust</td>
<td>Mental Health / Learning Disability Trust</td>
</tr>
<tr>
<td>TAF</td>
<td>Camden and Islington NHS Foundation Trust</td>
<td>Mental Health / Learning Disability Trust</td>
</tr>
<tr>
<td>TAH</td>
<td>Sheffield Health &amp; Social Care NHS Foundation Trust</td>
<td>Mental Health / Learning Disability Trust</td>
</tr>
<tr>
<td>TAJ</td>
<td>Sandwell Mental Health NHS and Social Care Trust</td>
<td>Mental Health / Learning Disability Trust</td>
</tr>
<tr>
<td>TAK</td>
<td>Bexley Care Trust</td>
<td>PCT</td>
</tr>
<tr>
<td>TAL</td>
<td>Torbay Care Trust</td>
<td>PCT</td>
</tr>
<tr>
<td>TAM</td>
<td>Solihull Care Trust</td>
<td>Mental Health / Learning Disability Trust</td>
</tr>
</tbody>
</table>